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Foreword
Thank you for purchasing the Harmonic/Flicker Analysis Software (Model 761922).

This user’s manual lists precautions that must be taken during use, and contains useful
information about the functions, and operating procedures of the Harmonic Measurement
Software within the Harmonic/Flicker Measurement Software.  To ensure correct use,

please read this manual thoroughly before beginning operation.  After reading the
manual, keep it in a convenient location for quick reference whenever a question arises
during operation.  For information about the handling precautions, functions, and

operating procedures of WT3000 Precision Power Analyzer (models 760301, 760302,
760303, and 760304) and the handling and operating procedures for Windows, see the
manuals for those products.

Notes
• The contents of this manual are subject to change without prior notice as a result of

continuing improvements to the instrument’s performance and functions.  The figures
given in this manual may differ from those that actually appear on your screen.

• Every effort has been made in the preparation of this manual to ensure the accuracy

of its contents.  However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

• Copying or reproducing all or any part of the contents of this manual without the

permission of Yokogawa Electric Corporation is strictly prohibited.
• The TCP/IP software of this product and the document concerning the TCP/IP

software have been developed/created by YOKOGAWA based on the BSD

Networking Software, Release 1 that has been licensed from California University.

Trademarks
• Microsoft, Windows, and Windows XP are either registered trademarks or trademarks

of Microsoft Corporation in the United States and/or other countries.
• Adobe and Acrobat are trademarks of Adobe Systems Incorporated.

• Other company and product names are trademarks or registered trademarks of their
respective companies.

• For purposes of this manual, the TM and  symbols do not accompany their

respective trademark names or registered trademark names.

Revisions
• 1st Edition March 2006
• 2nd Edition December 2006
• 3rd Edition September 2008
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the
“Yokogawa Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing  the Yokogawa Software Program, you acknowledge that you
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the
documentation and separately attached.  Accordingly, the Terms and Conditions bind you.

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa
or those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT
TO YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software
Program (hereinafter called the “Licensed Software”) to the Licensee  on the conditions that the Licensee agrees to the terms and conditions
stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called
the “Agreement”) based on the use intended for the Licensed Software.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.
Licensed Software Name: Harmonic/Flicker Analysis Software Model 761922
Number of License: 1

Article 1 (Scope Covered by these Terms and Conditions)
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the

Licensee consents to agree to the terms and conditions stipulated herein.
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary

technology, algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the

license fee separately agreed upon by both parties.
2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the

Licensed Software.
2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes.  The Licensee shall

secure or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.
2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee

may translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed
Software.  Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed
Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which
grants Yokogawa the rights.  In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the
Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software.  In no event shall the Licensee remove or attempt to remove
such copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which
may include any software program from affiliates of Yokogawa made or coded by themselves.)  In the case that Yokogawa is granted
permission to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions
than those stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in
writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for

the purpose of the following events:
a) Operation of any aviation, vessel, or support of those operations from the ground;,
b) Operation of nuclear products and/or facilities;,
c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or
responsibility for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own
responsibility, to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any
liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims
arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such

as damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any
Licensed Software on condition that the defective Licensed Software shall be returned to Yokogawa’s specified authorized service facility
within seven (7) days after opening the Package at the Licensee’s expense.  As the Licensed Software is provided to the Licensee on an “as
is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation,
data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms
and conditions that apply shall be those established by the provider of the third party software.
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4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for
any failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing
the Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in
warranty, contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or
arising out of the use of the Licensed Software.

Article 5 (Infringement)
5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under

patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party.  Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for
Yokogawa’s defense and negotiation.  If and when such a claim should be attributable to Yokogawa, subject to the written notice to
Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s
cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa’s cost and expense.
a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use

the Licensed Software;
b) To replace the Licensed Software with an alternative one which avoids the infringement; or
c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the
Licensee.  THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING
THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS
INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided

to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement.  However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue,
loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s
business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa
and to the extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software
or service fee which Yokogawa has received.  Please note that Yokogawa shall be released or discharged from part or all of the liability under
this Agreement if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic
specifications or functional specifications, without Yokogawa’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts
between the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement.  However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved
amicably through negotiation between the parties upon the basis of mutual trust.  Should the parties fail to agree within ninety (90) days after
notice from one of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main
office) in Japan for settlement of the dispute.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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Chapter 1 Product Overview

1.1 Explanation of Functions

This software application (761922) measures harmonic currents of electrical equipment
according to an applicable IEC standard, (see section 1.3 for an overview) and displays/
saves the results of evaluations made according to the standard.

Applicable Measurement Instruments
This software can be used with Yokogawa’s measurement instruments listed below. This

user’s manual (IM761922-02E) describes the case when this software is used in
combination with the WT3000. For information regarding the case when WT1600 or
WT2000 series is used, see IM761922-01E.  For information about the handling

precautions, functions, and operating procedures of each WT, see the respective
manuals.

Product Model

WT3000 760301, 760302, 760303, and 760304

WT1600 760101

WT2000 series 253101, 253102, and 253103

Applicable Standard
For the applicable standards, see section 1.3.

Retrieving and Loading of Measured Data/Waveform Data to Be Evaluated
Setting WT Measurement Conditions

This software application can be used to enter the same harmonic measurement

conditions that you can enter using the front panel keys of the WT.

Retrieving Measured Data from the WT Connected On-Line (On-Line Mode)
The measured data to be evaluated against the standard can be retrieved into your
PC via the GP-IB or Ethernet interface while making harmonic measurements on the
WT.

Loading Measured Data Already Saved (Off-Line Mode)
The measured data retrieved by the software can be saved.  The saved measured

data/waveform data can be loaded to be evaluated against the standard.
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Measurement Modes
This software has three measurement modes: Harmonic Measurement, Harmonic

Monitor, and Waveform Monitor. The type of data retrieved and the operation vary
depending on the measurement mode.
Harmonic Measurement Mode

• When in On-Line Mode
Measurement and evaluation of harmonics conforming to “IEC 61000-3-2 Edition
3.0” or JIS can be made while making harmonic measurements on the WT.

10 cycles (for 50 Hz)
12 cycles (for 60 Hz)

of the fundamental frequency

10 cycles (for 50 Hz)
12 cycles (for 60 Hz)

of the fundamental frequency

Measures the harmonics Measures the harmonics

Retrieves the measured data
on the PC and stores them as
instantaneous values

Retrieves the measured data
on the PC and stores them as the
next set of instantaneous values

Measures the harmonics 
using the measurement 
conditions entered according 
to the applicable standard

Measurement time

One set of harmonic measurement data (handled as instantaneous values by the
software) consists of harmonic data measured every 200 ms (10 cycles for 50 Hz
and 12 cycles for 60 Hz). The instantaneous values, the mean value, and the

maximum value of the measured data retrieved within the measurement time (see
next page) can be evaluated to determine whether they are within the limits of the
standard.

• When in Off-Line Mode
Evaluation can be made on the loaded measurement data according to the method
complying with IEC 61000-3-2 Edition 3.0 or JIS.

Harmonic Monitor Mode
This mode can be selected only when in On-Line mode.  Harmonic fluctuation can be

monitored on bar graphs and a numerical list while making harmonic measurements
on the WT.  This mode is used to monitor the conditions of the harmonics and does
not evaluate against the standard as in Harmonic Measurement Mode.  When the

next measured data is retrieved, the previous measured data is updated and does not
remain.

10 cycles (for 50 Hz)
12 cycles (for 60 Hz)

of the fundamental frequency

10 cycles (for 50 Hz)
12 cycles (for 60 Hz)

of the fundamental frequency

Measures the
harmonics

Measures the
harmonics

Measures the harmonics 
using the measurement 
conditions entered 
according to the 
applicable standard

Retrieves the measured data 
on the PC and displays a bar 
graph or numerical list

Retrieves the measured data 
on the PC and displays a bar 
graph or numerical list

The previous measured data is 
updated and does not remain.

1.1  Explanation of Functions
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1Waveform Monitor Mode
This mode can be selected only when in On-Line mode.  The measured waveform

can be monitored while making harmonic measurements on the WT.  This mode is
used to monitor the conditions of the waveform and does not evaluate against the
standard as in Harmonic Measurement Mode.  When the next waveform data is

retrieved, the previous waveform data is updated and does not remain.

Approx. 2 cycles at the
fundamental frequency

Samples the
waveform data

Approx. 2 cycles at the
fundamental frequency

Samples the
waveform data

Retrieves the waveform 
data on the PC and 
displays the waveform

Retrieves the waveform 
data on the PC and 
displays the waveform

The previous waveform data is 
updated and does not remain.

Setting the Standard and Measurement Environment
Sets the classification of the equipment under test (EUT) as defined in IEC 61000-3-2
Edition 3.0 or JIS and evaluation conditions within each class.

Setting the Measurement Time
The measurement time is the time between the start of the measurement to the end of
the measurement.  The time for measuring harmonics is set in units of 1 s in advance.

The harmonics can be measured continuously for the specified time.  The measurement
time can be changed when equipment that emits harmonics that fluctuate over time is
measured or when confirming that the emitted harmonics do not change even when the

equipment is operated over extended time.

Setting the Title/Comment of Reports
A title or a comment of a report can be entered and saved or printed along with the

harmonic measurement data.  When printing, you can select whether to use color or
black and white.

Starting/Stopping Measurements
Harmonic measurement on the WT can be started from your PC when in On-Line mode.
The measurement cannot be started when in Off-Line mode.

When in Harmonic Measurement Mode
When harmonic measurement on the WT is started from the PC, the harmonics data
measured on the WT is retrieved and stored on the PC.  The next data is retrieved

and stored as next data.  All the data retrieved within the measurement time are
stored.  When the specified measurement time elapses, the measurement
automatically stops as well as the data retrieval.  You can also abort the measurement

and data retrieval from the PC before the specified measurement time elapses.

When in Harmonic Monitor or Waveform Monitor Mode
When harmonic measurement on the WT is started from the PC, the harmonics data

or waveform data measured on the WT is retrieved and stored on the PC.  When the
next data is retrieved, the previous data is updated and does not remain.  These
modes are used to monitor the conditions of the harmonics and waveforms and do not

evaluate against the standard as in Harmonic Measurement Mode.  To stop the
measurement and data retrieval in these modes, press the Stop button.

1.1  Explanation of Functions
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Displaying the Evaluation Results and Measured Data/Waveform Data
The result of the evaluation as to whether the harmonic current data up to order 40 is

within the limits of IEC 61000-3-2 Edition 3.0 or JIS and the corresponding measured
data can be displayed.  Various displays below are possible only when in Harmonic
Measurement mode.

Display of the Evaluation Result within the Entire Measurement Time
Evaluation can be made as to whether all of the harmonic measurement data in the

measurement time are within the limits according to the settings specified in “Setting
the Standard and Measurement Environment” (as described earlier), and the results
can be displayed collectively.

Bar Graph Display of Harmonic Current/Voltage
Bar graphs of the harmonic measurement data and the standard limits can be
displayed for each order.  Moreover, the evaluation as to whether harmonic current

data is within the limits can be displayed using different colors.  The harmonic current
data to be evaluated is the mean value, the maximum value, and instantaneous
values (one set of harmonic measurement data) of the measured data within the

measured time.  Both harmonic current and voltage can be displayed for each input
element of the WT.

List Display of Harmonic Current/Voltage
A list of the harmonic measurement data and the standard limits can be displayed for
each order.  Moreover, the evaluation as to whether harmonic current data is within

the limits can be displayed using different colors.  The harmonic current data to be
evaluated is the mean value, the maximum value, and instantaneous values
(individual measurement data) of the measured data within the measured time.  Both

harmonic current and voltage can be displayed for each input element of the WT.

Fluctuation Graph Display of Harmonic Current
Graphs of the harmonic current fluctuation over time can be displayed for each order.

The lists can be displayed for each input element of the WT.

Waveform Display of Voltage/Current
The waveform immediately after the end of the measurement can be displayed.
Approximately 2 cycles of waveform is displayed.  You can place the cursor on the
current waveform and read the phase difference (phase angle) from the first zero-

crossing point of the voltage waveform and the current value of the phase.  The list
can be displayed for each input element of the WT.

Fluctuation Graph Display of Voltage/Current/Active Power
Graphs of the fluctuation of the rms value of the voltage and current as well as the
active power that is determined from the measured fundamental frequency and all
harmonics can be displayed.  The list can be displayed for each input element of the

WT.

Bar Graph Display of the Phase Angle of the Harmonic Current
Bar graphs of the phase angle of the harmonic current with respect to the
fundamental signal for each order can be displayed.  The list can be displayed for
each input element of the WT.

List Display of the Phase Angle of the Harmonic Current
A list of the phase angle of the harmonic current with respect to the fundamental
signal for each order can be displayed.  The list can be displayed for each input

element of the WT.

1.1  Explanation of Functions
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Saving and Loading Setup Information

Setup information such as the measurement mode, standard and measurement
environment settings, measurement time, display format of bar graph and numerical
list, title/comment of reports (one-page reports containing the bar graph/numerical list

of the measured data and evaluation results) specified by the software can be saved.
The setup information saved to a file can also be loaded.

Saving and Loading Measured Data/Waveform Data
The harmonic measurement data or waveform data retrieved from the WT in harmonic
measurement mode into the PC using the software can be saved to a file.  In this
case, the harmonic measurement conditions of the WT specified using the software

and the same data as the setup information described above are also saved.  The
harmonic measurement data, waveform data, harmonic measurement conditions, and
setup information saved to a file can also be loaded.

Saving the Measured Data or Waveform Data in CSV Format
The harmonic measurement data or waveform data retrieved from the WT into the PC

using the software can be saved to a file in CSV format.  The software cannot load the
data saved to a CSV file.  Software applications installed on the PC that support files
in CSV format can open the data.

Saving and Printing Screen Images and Reports
Screen images and reports can be saved to files in BMP format or printed.

• The active window among the displayed graph and list windows can be saved in BMP
format or printed.

• A list or bar graph of the harmonic measurement data can be saved in BMP format or

printed as a report.  A title or comment can be attached to a report (see “Setting the
Title/Comment of Reports” on page 1-3).

1.1  Explanation of Functions
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Repeatability of Measured Data
The mean value in the harmonics measurement data saved to files can be compared,

and the difference in the measured data can be displayed on a bar graph or numerical
list for each order.  This function can be used to evaluate whether the difference between
data measured under the same measurement conditions when harmonics are measured

using the same product or same product model is within 5% of the limits (confirmation of
repeatability).

File 1

Mean1

File 2

Mean2

File 3

Mean3

File N

MeanN

Mnmean Harmonic orders (2 to 40)

Mnmax

Mnmin

Mnmax – Mnmean
Mnmean

×100 is the 5% line

Mnmin – Mnmean
Mnmean

×100 is the –5% line

Mnmean = (Mean1 + Mean2 + Mean3 + ... + MeanN)/N
(Mnmean: The value derived by summing the mean values of each file (Mean1,
Mean2, Mean3, ... MeanN) and dividing by the number of summed values (N).  The

value can be determined for each order.)
Mnmax = [Mean1, Mean2, Mean3, ..., MeanN]max

(Mnmax: The maximum value among the mean values of each file.  The value can be

determined for each order.)
Mnmin = [Mean1, Mean2, Mean3, ..., MeanN]min

(Mnmin: The minimum value among the mean values of each file.  The value can be

determined for each order.)

1.1  Explanation of Functions
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11.2 System Requirements

PC
CPU

Pentium III 1 GHz or equivalent or faster

Memory
256 MB or more

HDD
Free space of at least 2 GB.

Operating System
Windows 2000 Professional, Windows XP Home Edition, or Windows XP Professional.

Communication card
GP-IB

PCI-GPIB/PCI-GPIB+/PCMCIA-GPIB/PCMCIA-GPIB+ by National Instruments with
NI-488.2 driver version 1.60 or later (however, version 2.3 is not supported).

Ethernet
A 100BASE-TX Ethernet port.

Display, Printer, and Mouse
Must be compatible with the operating systems listed above.

WT3000
WT3000 firmware version 3.01 or higher with the following functions.
• Advanced computation function (option)

• GP-IB interface (standard) or Ethernet interface (option)
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1.3 Applicable Standards

The applicable standards of this software application are as follows:
• IEC 61000-3-2(Electromagnetic compatibility (EMC) - Part 3-2: Limits - Limits for

harmonic current emissions (equipment input current ≤ 16 A per phase)) Edition 3.0

and A1 of the Edition 3.0
• EN61000-3-2 (2006)
• IEC61000-4-7 Edition 2

• JIS C61000-3-2 (2005) JIS: Japanese Industrial Standard
This section gives an overview of the standards. For further details, see the actual text of
the applicable standard.

Scope and Classification
The limits for harmonic current emissions (IEC61000-3-2 or JIS) are applicable to

electrical and electronic equipment having an input current of up to 16 A (up to 20 A for
JIS) per phase and connected to public low-voltage distribution systems. Classification is
made depending on the type of equipment. IEC 61000-3-2 Edition 3.0 does not define

the limits for some types of equipment. For details, see the applicable standard.

• Balanced three-phase equipment
• Household appliances, excluding 

equipment identified as Class D
• Tools excluding portable tools 

(portable tools are Class B)
• Dimmers for incandescent lamps
• Audio equipment
• Equipment not specified in one of 

the other three classes (B, C, and 
D)

Class A

 Portable tools

Class B

 Television receivers, personal computers (PCs), 
and PC monitors with a rated power of 600 W or 
less

Class D

 Lighting equipment

Class C

Electrical and electronic equipment having an input current up to 16 A per phase

Arc welding equipment 
which is not professional 
equipment

Limits
The limits are specified for each class. IEC 61000-3-2 assumes a phase voltage of 220
V, 230 V, and 240 V for specifying the limits. For equipment of differing rated voltage,
conversion may be necessary. For the conversion equation, see “Conversion of Limits”

(page 1-10). The limits of JIS C-61000-3-2(2005) are the same as those of IEC61000-3-
2. However, limits indicated on the next page apply to air conditioners of class A whose
active power exceeds 600 W.

Limits for Class A Equipment

Harmonic order

n
Odd harmonics

3
5
7
9

11
13

15≤n≤39
Even harmonics

2
4
6

8≤n≤40

Maximum permissible

harmonic current [A]

2.30
1.14
0.77
0.40
0.33
0.21

0.15×(15/n)

1.08
0.43
0.30

0.23×(8/n)
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1In JIS C61000-3-2(2005), the limits below apply to air conditioners whose active
power exceeds 600 W.

Even harmonics

Odd harmonics

Maximum permissible harmonic 
current

2.30+0.00283(W-600)
1.14+0.00070(W-600)
0.77+0.00083(W-600)
0.40+0.00033(W-600)
0.33+0.00025(W-600)
0.21+0.00022(W-600)

(0.15+0.00020(W-600))×(15/n)

1.08+0.00033(W-600)
0.43+0.00017(W-600)
0.30+0.00012(W-600)

(0.23+0.00009(W-600))×(8/n)

[A]

3
5
7
9
11
13

15≤n≤39

2
4
6

8≤n≤40

Harmonic order 
n

Limits for Class B Equipment

Limits for Class A equipment×1.5

Limits for Class C Equipment
Classification is made according to the active power of the equipment shown below.
For single-phase equipment, the classification is made using the active power of the

single-phase power.  For multi-phase equipment, the classification is made using the
sum of the active powers all phases (three phases if three-phase).
• Equipment with active input power exceeding 25 W

Maximum permissible harmonic current
expressed as a percentage of the input

current at the fundamental frequency [%]
2

30×λ*
10
7
5
3

* λ is the power factor (circuit power factor).
 For the fundamental current and power factor, use the measured values 

under maximum load conditions of the equipment.

Harmonic order
n

2
3
5
7
9

11≤n≤39
(Odd harmonics only)

• Equipment with active input power less than or equal to 25 W
Shall meet one of the two conditions below.

1. Does not exceed the power ratio limits of Class D.
2. The third and fifth harmonics shall not exceed the limits given in the table below.

Moreover, the relationship of the fundamental voltage waveform and the input

current waveform shall be as shown in the figure below.

Harmonic order
n

3
5

Maximum permissible harmonic current
expressed as a percentage of the input

current at the fundamental frequency [%]
86
61

1.3  Applicable Standards
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The relationship of the fundamental supply voltage waveform and the input current
waveform is as follows, where the zero crossing of the fundamental supply voltage is
assumed to be at 0° (degrees).

• Beginning of the current flow: Before or at 60°

• Last current peak: Before or at 65°

• End of the current flow: 90° or after

0°

60° 65° 90°
Voltage

Current

Limits for Class D Equipment
Shall meet the maximum permissible harmonic current (power ratio limit) per watt and

the maximum permissible current given in the next table.  The concept of power
(active power) of single- or multi-phase equipment is the same as Class C.

Maximum permissible harmonic
current per watt [mA/W]

(Power ratio limit)

3.4
1.9
1.0
0.5
0.35

3.85/n

Maximum permissible
harmonic current

(Odd harmonics only)
[A]

2.30
1.14
0.77
0.43
0.33

Same as class A.

Harmonic order
n

3
5
7
9
11

13≤n≤39
(Odd harmonics only)

Conversion of Limits
IEC 61000-3-2 assumes a phase voltage of 220 V, 230 V, and 240 V for specifying
the limits.  For equipment of differing rated voltage, conversion may be necessary.

Convert the limits of all the classes using the following equations and apply them.
However, conversion to a phase voltage of 220 V or 240 V is not necessary.

Converted limit = Limit of each class ×
230

Rated voltage of the equipment

Phase voltage

Converted limit = Limit of each class ×
400

Rated voltage of the equipment

Line voltage of three-phase

1.3  Applicable Standards
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1Specifications of Supply Source, Measurement Equipment, Test Conditions, and
Application Method of Limits.

This section lists only the items.  For detailed specifications, see the applicable standard.
Power Supply

• Supply voltage and frequency range.

• Permissible range of harmonics contained in the supply voltage.
• Voltage peak value and phase offset between the waveform zero crossing and the

peak value.

• Internal impedance of the supply source.
• Angle between the fundamental voltage on each pair of phases in the case of a

three-phase source.

Measurement Equipment
• Error of the measurement equipment.

• Input impedance of the measurement equipment.
• Time constant of the internal processing when measuring harmonics.

Test Conditions
• Test conditions for television/audio equipment and lighting equipment.
• Test conditions for general equipment not specified in the applicable standard.

For example, performing tests by setting the equipment to a condition that
produces the maximum total harmonic current (THC).

• Specification of the repeatability of the measurement results.

• Specification of the observation time (measurement time) to achieve the
repeatability of the measurement results.

Application Method of Limits
• Derivation of the fundamental current and power factor (circuit power factor) of

class C equipment.

• Derivation of the power (active power) used by class D equipment
• Specifications when comparing the harmonic current limits and measured values

for each order.

• Compare the specified limit and the mean value of the harmonic current within
the measurement time and evaluate.

• Compare the value that is 1.5 times the specified limit and the maximum value

of the harmonic current within the measurement time and evaluate.
• 200% short-term relaxation conditions

If all of the following conditions are met, up to 200% of the specified limits is

permitted.
• The EUT belongs to Class A for harmonics.
• The excursion beyond 150 % of the applicable limits lasts less than 10 % of the

test observation period or in total 10 min (within the test observation period),
whichever is smaller.

• The average value of the harmonic current, taken over the entire test

observation period, is less than 90 % of the applicable limits.
• POHC relaxation of the specification

If the total partial odd harmonic currents (POHC) of order above and including 21 is

less than the specified POHC limit, the average of the odd harmonic currents of
order above and including 21 is permitted to be 1.5 times the specified limits.

1.3  Applicable Standards
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Decision Process for Determining Whether 200% Short-Term Relaxation or POHC
Relaxation Is Applicable

Measurement execution

Pass Fail

Yes

No

Yes (Class A)

No

Yes (≤ 90%)

Yes (≤ 200%)

Yes

No

Yes

No (> 90%)

No (> 200%)

No

Meets the POHC relaxation 
condition1

The maximum value is less 
than or equal to 200% of the 
limits.

Period during which 150% is 
exceeded2 ≤ Excursion period 
limit3

The average value is less than 
or equal to 90% of the limits.

Meets the limits specified in the 
standard (Edition 2.2)

The EUT is of class A.

1 The 200% short-term relaxation and POHC relaxation cannot be applied together to a single test.

2 Period during which instantaneous values exceed 150% of the applicable limit.

3 10% of the test observation period or 10 minutes (within the test observation period), whichever is smaller.

Window Function of the WT3000 and WT2000/WT1600 (Measurement Period)
• The width of the window function (measurement period) for the measurements on the

WT3000 is 200 ms (10 cycles at 50 Hz and 12 cycles at 60 Hz) as defined by

IEC61000-4-7 Edition 2.
• The width of the window function (measurement period) for the measurements on the

WT2000/WT1600 is 16 cycles as defined by IEC61000-4-7 (1991).

1.3  Applicable Standards
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11.4 Flow of Operation (GP-IB)

To display and evaluate harmonic measurement data using this software, the WT Digital
Power Meter and PC must be connected via the GP-IB interface, the software must be
installed, WT measurement conditions must be set, and evaluation conditions of the

applicable standard must be set.  Follow the steps below.

Preparation Flow Chart

Connect the WT and PC via GP-IB (section 2.1)

Install the software (section 2.4)

P
rep

aratio
n

On-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic 
Measurement

Measurement mode: Harmonic 
Monitor or Waveform Monitor

Execute the measurement
(section 3.7)

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)

Save setup information or
measured data (chapter 6)

Save screen images (section 7.1)

Execute the measurement
(chapter 5)

Monitor harmonics and
waveforms (chapter 5)

Print screen images
(sections 7.3 to 7.5)Save screen

images (section 7.1)

Select the WT GP-IB
address (section 2.5)

Set the WT measurement
conditions (section 3.3)

Set the evaluation conditions of
the standard (sections 3.5 and 3.6)

Set standard and measurement
environment (section 3.5)

S
et m

easu
rem

en
t co

n
d

itio
n

s an
d

 evalu
atio

n
 co

n
d

itio
n

s
E

xecu
te th

e
m

easu
rem

en
t

P
ro

cess th
e

m
easu

red
 resu

lts

Online or
Offline

(section 2.5)

Select WT
(section 2.5)

Select the measurement
mode (section 3.4)

Online

Select the WT GP-IBaddress 
(section 3.1)

Select Online
(section 3.2)

Offline

Switch from
Offline to Online

(see the next page)
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Off-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic Measurement 

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)Save the setup

information (section 6.1)

Set standard and measurement
environment (section 3.5)

S
et th

e evalu
atio

n
 co

n
d

itio
n

s
P

ro
cess th

e resu
lts

Online or Offline
(section 2.5)

Online

Load the setup information or
measured data (sections 3.9 and 6.2)

Select Offline
(section 3.8)

Offline

(See the previous page)

Switch from
Online to Offline

1.4  Flow of Operation (GP-IB)



1-15IM 761922-02E

P
ro

d
u

ct O
verview

11.5 Flow of Operation (Ethernet : WT3000 Option)

To display and evaluate harmonic measurement data using this software, the WT and
PC must be connected via the Ethernet interface, the software must be installed, WT
measurement conditions must be set, and evaluation conditions of the applicable

standard must be set. Follow the steps below.

Preparation Flow Chart

Connect the WT and PC via Ethernet (section 2.1)

Install the software (section 2.4)

P
rep

aratio
n

On-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic 
Measurement

Measurement mode: Harmonic 
Monitor or Waveform Monitor

Execute the measurement
(section 3.7)

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)

Save setup information or
measured data (chapter 6)

Save screen images (section 7.1)

Execute the measurement
(chapter 5)

Monitor harmonics and
waveforms (chapter 5)

Print screen images
(sections 7.3 to 7.5)Save screen

images (section 7.1)

Select the WT Ethernet (TCP-IP) 
(section 2.5)

Set the WT measurement
conditions (section 3.3)

Set the evaluation conditions of
the standard (sections 3.5 and 3.6)

Set standard and measurement
environment (section 3.5)

S
et m

easu
rem

en
t co

n
d

itio
n

s an
d

 evalu
atio

n
 co

n
d

itio
n

s
E

xecu
te th

e
m

easu
rem

en
t

P
ro

cess th
e

m
easu

red
 resu

lts

Online or
Offline

(section 2.5)

Select WT
(section 2.5)

Select the measurement
mode (section 3.4)

Online

Select the WT Ethernet (TCP-IP) 
(section 3.1)

Select Online
(section 3.2)

Offline

Switch from
Offline to Online

(see the next page)
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1.5  Flow of Operation (Ethernet : WT3000 Option)

Off-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic Measurement 

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)Save the setup

information (section 6.1)

Set standard and measurement
environment (section 3.5)

S
et th

e evalu
atio

n
 co

n
d

itio
n

s
P

ro
cess th

e resu
lts

Online or Offline
(section 2.5)

Online

Load the setup information or
measured data (sections 3.9 and 6.2)

Select Offline
(section 3.8)

Offline

(See the previous page)

Switch from
Online to Offline
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11.6 Terminology Related to Harmonics

Harmonics refer to sine waves whose frequency is an integer multiple of the fundamental
wave (normally sine waves of commercial frequency 50-Hz or 60-Hz) excluding the
fundamental frequency.

Fundamental Signal (Fundamental Component)
The sine wave with the longest period among the different sine waves derived from

the periodic complex wave. Or the sine wave that has the fundamental frequency
within the components of the complex wave.

Fundamental Frequency
The frequency corresponding to the longest period in the periodic complex wave. The
frequency of the fundamental wave.

Distorted Wave
A wave that differs from the fundamental wave.

Higher Harmonic
A sine wave with frequency that is an integer multiple (twice or greater) of the
fundamental frequency.

Harmonic Component
Waveform component with frequency that is an integer multiple (twice or greater) of
the fundamental frequency.

Harmonic Order
Integer ratio of the harmonic frequency with respect to the fundamental frequency.
IEC defines the maximum harmonic order that is measured to be 40.

PLL Source
When measuring harmonics, the fundamental period (period of the fundamental
signal) must be determined in order to analyze the higher orders. The PLL (Phase

Locked Loop) source is the signal that is used to determine the fundamental period.

THC (Total Harmonic Component)
Sum (rms value) of harmonic currents of orders 2 to 40.

k = 2

I(k): rms current of each order
k:  harmonic order

40

I(k)2

THD (Total Harmonic Distortion)
The ratio of the rms value of all harmonics of orders 2 to 40 and the rms value of the
fundamental wave.

k = 2

40

U(k)2

U(1)

U(k):  rms voltage of each order,  U(1):  rms voltage of the fundamental signal
I(k):  rms current of each order,  I(1):  rms current of the fundamental signal
P(k):  active power of each order, P(1):  active power of the fundamental signal
k:  harmonic order

× 100 k = 2

40

I(k)2

I(1)
× 100

• V THD • A THD

k = 2

40

P(k)

P(1)
× 100

• P THD
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1.6  Terminology Related to Harmonics

Interharmonics
If the input signal is 50 Hz in IEC harmonic measurement, Fourier transform is taken

on 10 periods of the input signal to derive frequency components of 5-Hz resolution.
Thus, the section between each harmonic order is divided into 10 frequency
components. The components between each harmonic order are called

interharmonics.

100 150

Interharmonics

Rms component

Frequency [Hz]50 100 150 200 250dc

2nd harmonic 3rd harmonic 4th harmonic 5th harmonic
Fundamental 
signal

2nd harmonic 3rd harmonic

When the fundamental signal is 50 Hz

If the input signal is 60 Hz, 12 periods of the input waveform are divided into
frequency components of 5-Hz resolution. Thus, the section between each harmonic
order is divided into 12 frequency components.

Rms component

Frequency [Hz]60 120 180 240dc

2nd harmonic 3rd harmonic 4th harmonicFundamental signal

When the fundamental signal is 60 Hz
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1.6  Terminology Related to Harmonics

Harmonic Group
The combined value of a harmonic and its adjacent interharmonics (rms value). The

computing method to combine the harmonic and its two adjacent interharmonics is not
simple addition, but the square root of the sum of the square of each component. A
half of the amplitude is included for the interharmonic that is in the middle of two

harmonics.

When the fundamental signal is 50 Hz
Harmonic group Include a half of the amplitude

Ck

k k+1k-1 k+5k+4k+3k+2k-2k-3k-4k-5

Harmonic group
When the fundamental signal is 60 Hz

Ck

k k+1k-1 k+5k+4k+3k+2k-2k-3k-4k-5 k+6k-6

k–5C2

k+iC2

2
k+5C2

2
+Gg, n = + (for 50 Hz)

i=–4

4

k–6C2

k+iC2

2
k+6C2

2
+Gg, n =

Ck: frequency component for every 5 kHz

+ (for 60 Hz)
i=–5

5

Harmonic Subgroup
The combined value (rms value) of a harmonic and its two adjacent interharmonics.

The computing method to combine the components is the average of the sum of the
squares as with the harmonic group.

When the fundamental signal is 50 Hz
Harmonic subgroup

k k+1k-1

Ck

k+iC2Gsg, n =
i=–1

1

Ck: frequency component for every 5 kHz

THDG (Group Total Harmonic Distortion)
The ratio of the sum of all harmonic groups of orders 2 to 40 with respect to the group
related to the fundamental wave.

k = 2

40

Ug(k)2

Ug(1)
×100 k = 2

40

Ig(k)2

Ig(1)
×100

Ug(k), Ig(k): rms value of the harmonic group of each order
k:  harmonic order

• V THDG • A THDG
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1.6  Terminology Related to Harmonics

THDS (Subgroup Total Harmonic Distortion)
The ratio of the sum of all harmonic sub groups of orders 2 to 40 with respect to the

sub group related to the fundamental wave.

k = 2

40

Usg(k)2

Usg(1)
×100 k = 2

40

Isg(k)2

Isg(1)
×100

Usg(k), Isg(k): rms value of the harmonic subgroup of each order
k:  harmonic order

• V THDS • A THDS

Interharmonic Group
The combined value (rms value) of all interharmonic components between two
consecutive harmonic frequencies.

When the fundamental signal is 50 Hz

Interharmonic group

When the fundamental signal is 60 Hz

Interharmonic group

Interharmonic Center Subgroup
The combined value (rms value) of all interharmonic components between two
consecutive harmonic frequencies excluding the frequency components adjacent to
the harmonic frequencies.

When the fundamental signal is 50 Hz

Interharmonic center subgroup

When the fundamental signal is 60 Hz

Interharmonic center subgroup
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1200% Short-Term Relaxation
Calculating the period during which 150% of the applicable limit is exceeded and

determining whether or not the relaxation condition applies

H
ar

m
o

n
ic

 c
u

rr
en

t 
o

f 
ea

ch
 o

rd
er

150% of the limits

Measured values

Test observation period

t1 t3t2

When the test observation period is less than 100 minutes
t1 + t2 + t3 × 10% of the test observation period

When the test observation period is greater than or equal to 100 minutes
t1 + t2 + t3 < 10 minutes

POHC: The combined value of all odd harmonic currents greater than or equal to
order 21 (Partial Odd Harmonic Current)

k = 21, 23

39

I(k)2

I(k): rms current of odd harmonics above and including order 21
k:  harmonic order, odd value above and including 21

PoHC Maximum: The maximum value of the combined value of all odd harmonic
currents greater than or equal to order 21

The POHC maximum derived from individual measured data points within the

measurement time. If this value is less than the POHC Limit below, the relaxation
condition (see page 4-3) is applied.

POHC Limit

k = 21, 23

39

IL(k)2

IL(k):  limits of odd harmonics above and including 21 as specified by 
 the applicable standard
k:  harmonic order, odd value above and including 21

1.6  Terminology Related to Harmonics
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Crest Factor
The crest factor is defined as the ratio of the peak value of the waveform to the rms

value.

Peak value
RMS value

Crest factor (CF) =

Peak value

RMS value

Input signal waveform

The crest factor on the WT is determined by the maximum peak value that can be
applied for rated input in terms of a multiplication factor.

Peak value that can be input
Measurement range

Crest factor (CF) =

You can select a crest factor of 3 or 6 on the WT3000. For details on the
measurement accuracy and crest factor of the IEC standard, see chapter 10,

“Specifications.” Highly accurate measurements can be performed by setting the crest
factor to 3.

1.6  Terminology Related to Harmonics
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Chapter 2 Preparation before Use

2.1 Connecting the WT3000 and the PC

CAUTION
When connecting or disconnecting communication cables, make sure to turn
OFF the PC and the WT. Otherwise, erroneous operation or damage to the
internal circuitry may result.

When Controlling the WT through the GP-IB
The GP-IB connector used on the WT is a 24-pin connector that conforms to the IEEE
St’d 488-1978. Use a GP-IB cable that conforms to this standard. Connect the cable to
the GP-IB connector on the rear panel of the WT. For details on the connection

procedure and the specifications of the GP-IB interface, see the WT3000
Communication Interface User’s Manual IM760301-17E on the CD-ROM. Use an
appropriate connector for your PC to connect the other end of the GP-IB cable.

SERI(RS

100 BASE-TX

5

6.2

0V  MAX

V MAX

TORQUE

SPEED

D/A   OUTPUT

42Vpk MAX

GP- IB(IEEE488)

VIDEO-OUT
(VGA)

100-240V
200VA  MAX
FUSE  250V

AC

T

START

ETHERNET

CLK
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When Controlling the WT through the Ethernet Interface
Connect the WT and your PC through a hub using straight UTP (Unshielded Twisted-

Pair) or STP (Shielded Twisted-Pair) cables. Connect the cable to the ETHERNET port
on the rear panel of the WT. Use hubs, cables, and Ethernet NIC that are appropriate for
the data rate. For details on the connection procedure and the specifications of the

Ethernet interface, see the Expansion Function User’s Manual IM760301-51E of the
WT3000 and the WT3000 Communication Interface User’s Manual IM760301-17E on
the CD-ROM.

SERI(RS

100 BASE-TX

5

6.2

0V  MAX

V MAX

TORQUE

SPEED

D/A   OUTPUT

42Vpk MAX

GP- IB(IEEE488)

VIDEO-OUT
(VGA)

100-240V
200VA  MAX
FUSE  250V

AC

T

START

ETHERNET

CLK

100BASE-TX port

RJ-45 modular jack

Hub or router

UTP cable or 
STP cable (straight)

PC

Ethernet NIC

WT

Note
• Use UTP (Unshielded Twisted-Pair) or STP (Shielded Twisted-Pair) cables of category 5

or better when connecting to a 100BASE-TX network.

• Do not directly connect the WT to the PC without using a hub. Operations are not

guaranteed for communications using direct connection.

2.1  Connecting the WT3000 and the PC
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2.2 Setting the GP-IB Control

Procedure
1. Press MISC to display the Misc menu.

2. Press the Remote Control soft key to display the Remote Ctrl menu.
3. Press the Device soft key to select GP-IB.

Only the communication interface selected here is enabled. The WT does not

accept commands that are transmitted to other unselected communication
interfaces.

4. Press the cursor keys to set the address.
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Explanation
To use the software in On-Line mode through the GP-IB interface, operate the WT to
select GP-IB.

Setting the Address
Set the address of the WT within the following range.
1 to 30

Each device that can be connected via GP-IB has a unique address within the GP-IB
system. This address is used to distinguish the device from others. Therefore, make sure

that the WT address does not overlap with other devices when connecting the WT to the
PC.

Note
• Do not change the address while the controller (PC) or other devices are using the GP-IB

system.

• When connecting the WT to a single PC and controlling the WT using this software,

multiple communication interfaces cannot be used simultaneously.

• Use a GP-IB card by National Instruments on the PC end. For details, see section 1.2.

• The software may not operate correctly, if an adapter is inserted in the middle of the

connection between the WT and the PC (for example, GP-IB-to-USB adapter). For details,

contact your nearest YOKOGAWA dealer.

2.2  Setting the GP-IB Control
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2.3 Setting the Ethernet Control

Procedure
Setting the Ethernet Interface

1. Press MISC to display the Misc menu.
2. Press the Remote Control soft key to display the Remote Ctrl menu.
3. Press the Device soft key to select Network.

Only the communication interface selected here is enabled. The WT does not
accept commands that are transmitted to other unselected communication
interfaces.

Setting the User Name and Password
4. Press the User Account soft key to display the User Account dialog box.
5. Press the cursor keys to select User Name..

6. Press SET to display the keyboard.
7. Use the keyboard on the WT to enter the user name.

For the keyboard operation of the WT, see the WT User’s Manual.

8. Press the cursor keys to select Password.
9. Press SET to display the keyboard.
10. Use the keyboard on the WT to enter the password.

Enter the password twice for confirmation.
A password is not required if the login name is anonymous.
For the keyboard operation of the WT, see the WT User’s Manual.
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Setting the Timeout Value
11. Press the cursor keys to select Time Out.

12. Press SET to display the timeout time selection box.
13. Press the cursor keys to set the timeout value.
14. Press SET or ESC to close the box.

Setting TCP/IP
You must enter TCP/IP settings to control the WT from a PC through the network. For

the setup procedure, see the Expansion Function User’s Manual IM760301-51E of the
WT3000.

Explanation
To use the software in On-Line mode through the network, operate the WT to select
Network.

Setting the User Name
• Enter the user name to allow access to the WT.
• Enter up to 15 characters.
• The characters that can be used are 0-9, A-Z, %, _, ( ) (parentheses), - (hyphen).

• If you specify anonymous, the WT can be accessed from the PC without a password.

Setting the Password
• Enter the password of the user name to allow access to the WT.
• Enter up to 15 characters.
• The characters that can be used are 0-9, A-Z, %, _, ( ) (parentheses), - (hyphen).

• If you set the user name to anonymous, the WT can be accessed from the PC without
a password.

Setting the Timeout Value
The WT closes the connection to the network if there is no access for a certain period of
time (timeout value).

The available settings are 1 to 3600 s, or Infinite. The default value is Infinite.

Note
• To activate the settings, you must power cycle the WT.

• When connecting the WT to a single PC and controlling the WT using this software,

multiple communication interfaces cannot be used simultaneously.

• The software may not operate correctly, if an adapter is inserted in the middle of the

connection between the WT and the PC (for example, GP-IB-to-USB adapter). For details,

contact your nearest YOKOGAWA dealer.

2.3  Setting the Ethernet Control
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2.4 Installing the Software

Procedure
Have the CD-ROM containing the software ready. Exit all programs that are currently

running before starting the installation. If an older version of the Harmonic/Flicker
Measurement Software is installed, uninstall it first.
The following procedures are for installing the software on Windows 2000 Professional.

The screens shown in the figure may vary depending on the OS that is running on the
PC.

1. Start Windows.
When using Windows 2000, Windows XP Home Edition, or Windows XP Professional,

set the user name as an administrator when starting up.

2. Place the installation CD-ROM containing the software into the CD-ROM drive.
3. Double-click My Computer, then the CD-ROM icon.

4. Double-click Setup.exe. InstallShield Wizard starts.

Startup window of the InstallShield Wizard.

5. Click Next.



2-8 IM 761922-02E

6. If you accept the terms of with the license agreement, select Yes. If you do not,
select No.

Proceed to step 7.

Return to the previous screen.

Abort the installation.

When Yes is selected When No is selected

7. Select the installation destination, and click Next.
Click Browse to specify the installation destination. The default installation destination

is set to “C:\Program Files\Yokogawa\IEC61000 Analysis Software.”

2.4  Installing the Software
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8. Select the program folder where the program icon is to be added and click Next.
The installation starts.

The program icon (shortcut) of the software is added in the program menu of the Start

menu. The destination is selected here. The default program folder is Yokogawa.

9. If the installation completes successfully, a message “Setup has finished
installing” is displayed. Click Finish.

2.4  Installing the Software
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2.5 Starting and Exiting the Software

Procedure

Starting the Software
Starting the Software

1. From the Start menu, choose Programs > Yokogawa > IEC61000 Analysis >

IEC61000. The software starts.
The procedure above applies when the default software installation destination and

program folder are used. If you changed the installation destination or program folder at

installation, select the corresponding location.

When you start the software, a dialog box appears for you to select the
Regulation.

Selecting the Regulation
2. Select IEC61000-3-2.

Selecting the WT Model
3. Select WT3000.
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Selecting the Communication Mode
4. Select Online or Offline.

• If you selected Online, proceed to step 5.

• If you selected Offline, proceed to section 3.9.

Selecting the Crest Factor (CF)
5. Select CF3 or CF6.

Selecting the Communication Interface
6. Select GPIB or Ethernet.

If you selected GP-IB, proceed to step 7.
If you selected Ethernet, proceed to step 8.

Selecting the Communication Address
7. In the Initialize Interface dialog box that is displayed, select the GP-IB address

of the target WT.

Note
GP-IB address 0 cannot be selected, because it is reserved for use by the PC.

2.5  Starting and Exiting the Software
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Selecting the GP-IB address and clicking OK starts communications with the target
WT. After automatically confirming that communication is possible, an acquisition data

window appears. Setup and execution of measurements are now possible.

Acquisition Data Window
For a detailed description of the acquisition data window, see section 3.7.

Note
If the power to the target WT is not ON or the WT is not ready to make measurements, a

communication error occurs when communication is started after selecting the GP-IB address

and clicking OK. A communication error also occurs if the GP-IB address is not correct or if

there is no response from the target WT.

8. In the Connection dialog box, enter the IP address, user name, and password of

the target WT.

2.5  Starting and Exiting the Software
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Click OK to start communications with the target WT. After automatically confirming
that communication is possible, an acquisition data window appears. Setup and

execution of measurements are now possible.

Acquisition Data Window
For a detailed description of the acquisition data window, see section 3.7.

Note
If the power to the target WT is not ON or the WT is not ready to make measurements, a

communication error occurs when communication is started after setting the items in the

Connection dialog box and clicking OK. A communication error also occurs if the IP address,

user name, or password is not correct or if there is no response from the target WT.

Exiting the Software
Choose Exit from the File menu or click the     button in the upper right corner of the
Harmonic Analysis Software window. The software program closes.

2.5  Starting and Exiting the Software
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Explanation
A shortcut is located in the Programs folder of the Start menu. You can start the software
by selecting the shortcut. The software is saved to the installation destination that was
specified during installation described earlier.

Selecting the Regulation
To measure the harmonics, select IEC61000-3-2. If you select IEC61000-3-3, The

Voltage Fluctuation/Flicker Measurement Software starts.

Selecting the WT Model
You can select WT3000, WT1600, or WT2000.
If you are using the WT1600 or WT2000, see the Harmonic Analysis Software User’s
Manual IM761922-01E for the WT1600 or WT2000.

Selecting the Communication Mode
Select Online or Offline.

• Online
If you selected Online, you must set the communication interface of the target WT.

• Offline
If you selected Offline, communications with the WT is not possible. You can load
measured data and setup data that are already saved and display and print the
data. Proceed to section 3.8 and continue the operation.

Selecting the Crest Factor (CF)
You can select a crest factor of 3 or 6 on the WT3000. For details on the

measurement accuracy and crest factor of the IEC standard, see chapter 10,
“Specifications.” Highly accurate measurements can be performed by setting the crest
factor to 3.

Selecting the Communication Interface
• GP-IB

You must select the GP-IB address of the target WT.
• Ethernet

You must set the IP address, user name, and password of the target WT.

Selecting the Communication Address
• GP-IB

• You can select the GP-IB address of the target WT.
The selectable range is 1 to 30.

• Ethernet
• Set the IP address of the target WT.

Selectable range: 0.0.0.0 to 255.255.255.255
• You can set the user name and password of the target WT.

Characters that can be entered on the WT

Starting Communications
Selecting the GP-IB address and clicking OK starts communications with the target
WT.

2.5  Starting and Exiting the Software
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Chapter 3 Retrieving and Loading Measured Data/Waveform Data to Be Evaluated

3.1 Initializing the Communication Interface

The procedures described in sections 3.1 and 3.2 are not necessary immediately after
starting the software with the communication mode set to On-Line. To change the
communication mode from Off-Line to On-Line, follow the procedures given in sections

3.1 and 3.2.

Procedure
1. From the Communications menu, choose Initialize Interface. The Initialize

Interface dialog box opens.

2. Select CF3 or CF6.

3. Select the communication interface.

If you selected GP-IB, proceed to step 4.
If you selected Ethernet, proceed to step 5.

4. If you selected GP-IB in step 2, select the GP-IB address for the target WT.

Note
GP-IB address 0 cannot be selected, because it is reserved for use by the PC.

5. If you selected Ethernet in step 3, set the IP address, user name, and password
of the target WT.
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Explanation
When changing the communication mode from Off-Line to On-Line, you must set the
magnitude of the measured current and the communication interface of the target WT.

Selecting the Crest Factor (CF)
You can select a crest factor of 3 or 6 on the WT3000. For details on the
measurement accuracy and crest factor of the IEC standard, see chapter 10,

“Specifications.” Highly accurate measurements can be performed by setting the crest
factor to 3.

Selecting the Communication Address
GP-IB
• Select the GP-IB address of the target WT.

The selectable range is 1 to 30.
Ethernet
• Set the IP address of the target WT.

Selectable range: 0.0.0.0 to 255.255.255.255
• Set the user name and password of the target WT.

Selectable characters: Characters that can be entered on the WT

3.1  Initializing the Communication Interface
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3.2 Enabling On-Line Mode

Procedure
Carry out the procedure below after entering settings on the target instrument
according to the procedures given in section 3.1.

1. From the Communications menu, choose .

2. Select the crest factor (CF). Communications start with the target WT.

On the status bar of the window, check that Online is indicated.

Online

Note
When starting communications, an error will occur if the power to the target WT is not ON or

the WT is not ready to make measurements. A communication error also occurs if the GP-IB

address, IP address, user name, or password is incorrect or if there is no response from the

target WT.

Explanation
When changing the communication mode from Offline to Online, choose Online from the
menu after entering settings of the target WT. When you choose Online from the menu,

communications starts with the target WT. When communication begins, harmonic
measurement conditions of the WT are loaded into the software.

Selecting the Crest Factor (CF)
You can select a crest factor of 3 or 6 on the WT3000. For details on the
measurement accuracy and crest factor of the IEC standard, see chapter 10,
“Specifications.” Highly accurate measurements can be performed by setting the crest

factor to 3.
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3.3 Setting the Measurement Conditions of the WT

Procedure
From the Setting menu, choose WT Setting.  The WT Setting dialog box

opens.  You can also choose WT Setting from the Setup icon on the toolbar.
You can set the measurement conditions of the target WT.

     

Explanation
The measurement conditions of the WT can be set from this software via the GP-IB or
Ethernet interface.  For information about the settings, see “Setting Measurement
Conditions of the WT” in chapter 8.
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3.4 Setting the Measurement Mode to Harmonic
Measurement

Procedure
1. From the Setting menu, choose Measurement Mode.  The Measurement mode

setup dialog box opens.  You can also click  on the toolbar.

2. Choose Harmonic Measurement.
3. Click OK.  The Acquisition data window opens.

For details on the Acquisition data window, see section 3.7.

Explanation
To retrieve harmonic measurement data from the WT and evaluate the data according to

the IEC or JIS standard (see section 1.3), you must set the measurement mode to
Harmonic Measurement.  For a description of the function used to display the evaluation
results and measured data, see chapter 4.

Measurement Mode
The following three measurement modes are available.

• Harmonic Measurement Mode
This mode is used to retrieve harmonics measurement data from the WT and

evaluate the data according to the IEC or JIS standard (see section 1.3).  When the
communication mode is set to On-Line, evaluation can be made according to the
IEC standard while making harmonic measurements on the WT.  When the

communication mode is set to Off-Line, evaluation can be made on the
measurement data loaded from files according to the IEC standard.

• Harmonic Monitor Mode
Harmonic fluctuation can be monitored on bar graphs and numerical lists while
making harmonic measurements on the WT.  This mode can be selected only

when in On-Line mode.

• Waveform Monitor Mode
The measured waveform can be monitored while making harmonic measurements
on the WT.  This mode can be selected only when in On-Line mode.

Note
When you switch the measurement mode, all the data retrieved and loaded up to that point

are cleared.  It is recommended that the data retrieved using Harmonic Measurement Mode

be saved (see section 6.1) before changing the measurement mode.
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3.5 Setting the Standard and Measurement
Environment

Procedure
1. From the Setting menu, choose Standard and Measurement Environmental

Setup. The Standard and Measurement Environmental Setup dialog box opens.

You can also choose Standard and Measurement Environmental Setup from
the Setup icon on the toolbar.

2. Select the applicable standard.

Select the applicable standard
Select IEC or JIS.

3. From the Evaluate Class list in the Standard and Measurement Environmental
Setup dialog box, select the class of the EUT from A, B, C, and D according to

the specifications in the applicable standard.
The setup information varies depending on the selected class.
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Setting Class A or Class B
Set the class according to the explanation in the figure below.

Select the lower power limit for 
applying the limits
Select 50W, 75W, None, or Infinity.  When 
the active power of the EUT is less than 
the selected power, the limits are not 
applied.

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the 
value.  The limits are derived from to the 
specified system voltage.

Select Whether to Apply the Limit for Air Conditioners Exceeding 600 W for JIS
Class A

Select whether to apply the limit for air conditioners 
exceeding 600 W for JIS Class A

3.5  Setting the Standard and Measurement Environment
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Setting Class C
Set the class according to the explanation in the figure below.

• When the active power from the equipment exceeds 25 W (>25 W)
Measure the fundamental current and 
power factor
Set the load of the EUT to the maximum 
and click Pre-Meas.  The fundamental 
current and power factor are measured, and 
the values are displayed (only when online).

Set the supply voltage
Set the phase voltage or line voltage of the EUT.  You can 
also enter the value.  The limits are derived from the 
specified system voltage.

Fundamental current
The measured current at the fundamental 
frequency is displayed for each input 
element of the WT (e1, e2, and e3 denote 
element 1, element 2, and element 3, 
respectively).  You can also enter the value.

Power factor
The measured power 
factor is displayed.  You 
can also enter the value.

• When the active power from the equipment is less than or equal to 25 W (<=25
W)
You can select whether to evaluate by applying the power ratio limit of class D or to

evaluate on the conditions of harmonic order 3 and 5.

Measure the fundamental current
Set the load of the EUT to the maximum and 
click Pre-Meas.  The fundamental current is 
measured, and the value is displayed (only 
when online).  You can also enter the value.

Select the power
When applying the power ratio limits of 
Class D, select to use the maximum power 
measured by the EUT or a specified power 
value.

Evaluating by applying the power ratio
limits of Class D

Evaluating on the conditions of
harmonic order 3 and 5

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the 
value.  The limits are derived from to the 
specified system voltage.

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the value.  
The limits are derived from to the 
specified system voltage.

3.5  Setting the Standard and Measurement Environment
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Setting Class D
Set the class according to the explanation in the figure below.

Select the lower power limit for 
applying the limits
Select 50W, 75W, None, or Infinity.  When 
the active power of the EUT is less than 
the selected power, the limits are not 
applied.

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the value.  
The limits are derived from to the 
specified system voltage.

Select the power
When applying the power ratio limits of 
Class D, select to use the maximum 
power measured by the EUT or a 
specified power value.

3.5  Setting the Standard and Measurement Environment
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Explanation
To retrieve harmonic measurement data from the WT and measure/evaluate the data
according to the IEC or JIS standard (see section 1.3), you must select the class of the
EUT according to the specifications of the applicable standard and set the evaluation

conditions in each class.  Here, the procedure for switching the evaluation conditions for
each class is explained.  For a description of the classification specified in the standard
and the harmonic limits for each class, see section 1.3 or the applicable standard.

Standard (Regulation)
The software can make measurements and evaluations according to the IEC or JIS

standard (see section 1.3).

Class (Evaluate Class)
Select the class from A, B, C, and D, according to the classifications specified in the
standard.  The setup information varies depending on the class selected here.

Setting Class A
• Selecting the System Voltage

You can select the system voltage of the EUT or enter the value.  If the wiring

system is single-phase two-wire (1P2W), single-phase three-wire (1P3W), or three-
phase four-wire (3P4W), select or enter the phase voltage; if the wiring system is
three-phase three-wire (3P3W) or three-voltage three-current (3V3A), select or

enter the line voltage.  The limits are derived from the specified system voltage.
* Depending on the model, the “phase” is denoted as φ not P.

• Selecting the Lower Power Limit for Applying the Limits
Select 50W, 75W, None, or Infinity.  When the active power of the EUT is less than
the selected power, the limits are not applied.

• Selecting Whether to Apply the Limit for Air Conditioners Exceeding 600 W
for JIS Class A
In JIS Class A, special limits are defined for air conditioners that exceed 600 W.
You can select whether to apply this limit.

Setting Class B
The setup information is the same as class A.  The limits applied are 1.5 times the

limits for class A.

Setting Class C When the Active Power of the EUT Exceeds 25 W (>25 W)
• Selecting the System Voltage

Same as class A.
• Measuring the Fundamental Current and Power Factor

Measure the fundamental current and the power factor of the EUT that are required
for defining the limits.  Make the measurement by setting the load of the EUT to the
maximum.

Displaying the Current at the Fundamental Frequency
The measured current at the fundamental frequency is displayed for each input
element of the WT (e1, e2, and e3 denote element 1, element 2, and element 3,

respectively.  You can also enter the value.
Displaying the Power Factor
The measured power factor is displayed.  You can also enter the value.

3.5  Setting the Standard and Measurement Environment
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Setting Class C When the Active Power of the EUT Is Less Than or Equal to 25 W
(<=25 W)

The IEC standard specifies that either “the power ratio limits of class D” or “the
conditions of harmonic order 3 and 5” are met.
• Evaluating by Applying the Power Ratio Limits of Class D

The same power ratio limit of class D is applied.
Selecting the System Voltage
Same as class A.

Selecting the Power
You can select to use the maximum power measured by the EUT or a specified
power value.

• Evaluating on the Conditions of Harmonic Order 3 and 5
The IEC standard specifies the current ratio of harmonic order 3 and 5 to the
fundamental frequency and the relationship between the fundamental current and

the current waveform (see page 1-9).
Selecting the System Voltage
Same as class A.

Measuring the Fundamental Current
Measure the fundamental current of the EUT that is required for defining the limits.
Make the measurement by setting the load of the EUT to the maximum.

Displaying the Current at the Fundamental Frequency
The measured current at the fundamental frequency is displayed for each input
element of the WT (e1, e2, and e3 denote element 1, element 2, and element 3,

respectively.  You can also enter the value.

Setting Class D
• Selecting the System Voltage

Same as class A.
• Selecting the Power

You can select to use the maximum power measured by the EUT or a specified
power value.

• Selecting the Lower Power Limit for Applying the Limits
Select 50W, 75W, None, or Infinity.  When the active power of the EUT is less than
the selected power, the limits are not applied.

3.5  Setting the Standard and Measurement Environment
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3.6 Setting the Measurement Time

Procedure
1. From the Setting menu, choose Measurement Time Setup.  The Measurement

Time Setup dialog box opens.  You can also choose Measurement Time Setup
from the Setup icon on the toolbar.

2. Set the measurement time.

Explanation
Measurement Time
The measurement time is the time between the start of the measurement to the end of

the measurement.  The time for measuring harmonics can be set in advance.  The
harmonics can be measured continuously for the specified time.  The measurement
time can be changed when equipment that emits harmonics that fluctuate over time is
measured or when confirming that the emitted harmonics do not change even when

the equipment is operated over extended time.

Selectable range: 0 H 0 M 1 S to 24 H 0 M 0 S in units of 1 s.

• An error occurs if a time exceeding 24 hours is specified.
• If the measurement time is set to 0 H 0 M 0 S and the measurement is started,

measurement continues until you choose Stop from the Measure menu or click

Stop on the toolbar.

Note
Depending on the environment of the PC onto which this software was installed, an error

occurs if you specify a time longer than the memory area that can be reserved.  In this case,

you may be able to increase the available time by exiting other applications or by increasing

the amount of memory available to the PC.
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3.7 Starting and Stopping Measurements
(Retrieving Measured Data/Waveform Data)

Procedure
To start measurements and retrieve measurement data, the communication
mode must be set to On-Line and the measurement mode must be set to
Harmonic Measurement.

Starting Measurements
From the Measure menu, choose Start.  The retrieval of the harmonic
measurement data measured on the WT starts.  The retrieved measurement
data is displayed in the Acquisition data window (see the explanation given

later).  You can also click  on the toolbar.

Stopping Measurements
• Automatically Stopping Measurements

When the specified measurement time elapses, measurements automatically

stop.

• Aborting Measurements
From the Measure menu, choose Stop.  If the WT is in the middle of
measurement, measurement stops after the measurement correctly ends and
the retrieval of waveform data is finished.  You can also click  on the toolbar.

Explanation
Starting/Stopping Measurements

When in On-Line mode, measurement can be started.  Measurement cannot be
started in Off-Line mode.  When measurement is started in Harmonic Measurement

mode, the retrieval of the harmonic measurement data measured on the WT starts.
When the specified measurement time elapses, measurement is automatically
stopped.  You can also abort the measurement before the specified measurement

time elapses.  The waveform data is retrieved immediately after the measurement
stops.  For a description of the function used to display the measured data and
evaluation results, see chapter 4.

Note
When measurement is started in Harmonic Monitor or Waveform Monitor mode, the retrieval

of the harmonic measurement data or waveform data measured on the WT starts.  These

modes are used to monitor the conditions of the harmonics and waveforms and do not

evaluate against the standard as in Harmonic Measurement Mode.  To stop the measurement

and data retrieval in these modes, click Stop.  For details, see chapter 5.
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Displayed Contents of the Acquisition (Measurement) Data Window

Measurement (acquisition) data number
One set of harmonic measurement data (handled as instantaneous values) consists of harmonic data 
measured every 200 ms (10 cycles for 50 Hz and 12 cycles for 60 Hz). The software retrieves this data 
and displays the data as measured data. This example indicates that 751 sets of data have been 
retrieved and the first measured data is being displayed.

Meas Time
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.20 s) when the first measured data was retrieved.

Scroll bar
Drag the     (slider) or click           to select the measured data 
you wish to display.  The Meas Time and the Sample Count 
number change in sync with the slider position.

Up/Down button
Click to select the displayed measured data one by one.  The 
Meas Time, Sample Count number, and the slider position 
change in sync each time the Up/Down button is clicked.

Harmonic orders (orders 1 to 40)

Voltage value of each order (rms value)

Current value of each order (rms value)

Time elapsed since the start of 
measurement (displayed during 
measurement)

Indicates Online or Offline

Phase angle of the current of each order with respect to the fundamental current
However, the phase angle displayed on the 1st order line (–4.087° in this example) is 
the phase angle of the fundamental current with respect to the fundamental voltage.

WT input element
The displayed input 
elements vary depending 
on the wiring system 
configuration of the WT.

Preset measurement timeModel of WT Under Operation

Fundamental frequency of the PLL source

Active power

Harmonic distortion factor of voltage

Total harmonic distortion factor of voltage group

Total harmonic distortion factor of voltage subgroup

Harmonic distortion factor of current

Total harmonic distortion factor of current group

Total harmonic distortion factor of current subgroup

Harmonic distortion factor of power

Total harmonic current

Sum of odd harmonic currents of order above and  
including 21
Sum of odd harmonic currents of order above and 
including 21 (maximum value)

For details on each item, see section 1.6.

3.7  Starting and Stopping Measurements (Retrieving Measured Data/Waveform Data)
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Error Messages during Measurement
The following error message may appear when measurement is executed in Harmonic
Measurement mode.

This software retrieves large amount of measured data from the WT. The error message

may appear if the CPU on the PC is overloaded and cannot keep up with the data
transfer. Lighten the load placed on the CPU on the PC by checking the points listed
below.

• Do not operate or run other programs.
• Close memory-resident programs (turn them OFF).
• Disable the standby mode.

• Use the software on a PC that satisfies the system requirements given in section 1.2.

3.7  Starting and Stopping Measurements (Retrieving Measured Data/Waveform Data)
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3.8 Switching to Off-Line Mode (Switching from
On-Line Mode to Off-Line Mode)

Procedure
From the Communications menu, choose Off-Line.  Communications with the
target digital power meter is disconnected and a message “Communication with

GPIB was ended” appears.

On the status bar of the window, check that Offline is indicated.

Offline

Explanation
When the communication mode is changed from On-Line to Off-Line, communications
with the target digital power meter is disconnected.  You can also make evaluations

according to the IEC or JIS standard (see section 1.3) by loading measured data already
saved to a file in Off-Line mode.  For a description of the function used to display the
evaluation results and measured data, see chapter 4.

Note
To change the communication mode from Off-Line back to On-Line, follow the procedures

given in sections 3.1 and 3.2.
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3.9 Loading Setup Information, Measured Data,
and Waveform Data

Procedure
Note

• Setup information, measured data, and waveform data cannot be loaded when the

measurement mode is set to Harmonic Monitor or Waveform Monitor.

• If an error occurs while loading the setup information, the settings are reset to thier default values.

• If an error occurs while loading setup information, measured data, or waveform data, the data

may not be loaded properly.  Check the file name and extension, and load the data again.

• Setup information, measured data, and waveform data cannot be loaded while measurement

is in progress.

Loading Setup Information
1. From the File menu, point to Load then choose Load Setup Information.  The

Open dialog box opens.  You can also select Load Setup Information from the
Load icon on the toolbar.

2. Select a file name and click Open.  The setup information of the selected file is

loaded.

Loading Measured Data, Waveform Data, and Setup Information
Measured data, waveform data, and setup information can be loaded when the

measurement mode is set to Harmonic Measurement.
1. From the File menu, point to Load then choose Load Measured Data.  The

Open dialog box opens.  You can also select Load Measured Data from the

Load icon on the toolbar.
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2. Select a file name and click Open.  The measured data, waveform data, or
setup information of the selected file is loaded.

Explanation
Loading Setup Information

The setup information saved in section 6.1 can be loaded.

• The extension of the loaded file is .cfg.
• The details of the setup information are as follows.

• Measurement mode (see section 3.4).

• Standard and measurement environment settings (see section 3.5).
The measurement data retrieved from the WT or loaded from a file can be
evaluated using the loaded evaluation conditions.

• Measurement time (see section 3.6).
• Display settings (chapters 4 and 5).
• Title/Comment of Reports (see section 7.2).

Reports of measurement data retrieved from the WT or loaded from a file can be
saved or printed by attaching the loaded title or comment.  For the saving and
printing procedure, see chapter 7.

Loading Measured Data, Waveform Data, and Setup Information
• The measurement data, waveform data, and setup information saved in section 6.1

can be loaded.

• Measured data can be loaded when the measurement mode is set to Harmonic
Measurement.

• When one of the files with .bt1, .bt2, .bt3, and .bt4 extension is selected in the

Open dialog box and loaded, the data of all the files with the same file name in the
same directory is loaded.  See the following table.

Data Type Extension

WT3000 Measured data on the left side of the acquisition data window .bt1

Measured data in the center of the acquisition data window .bt2

Measured data on the right of the acquisition data window .bt3

Measured data common to all input elements .bt4

Waveform data on the left side of the acquisition data window .bw1

Waveform data in the center of the acquisition data window .bw2

Waveform data on the right side of the acquisition data window .bw3

Harmonic measurement conditions of the WT .inf
• If the communication mode is On-Line, the harmonic measurement conditions of the loaded

file are applied to “WT Setting” (chapter 8) of the software and transmitted to the WT.  If the
transmitted harmonic measurement conditions do not match the configuration of the WT, an
error message appears.  Check the configuration of the connected WT.

• If the communication mode is Off-Line, the harmonic measurement conditions of the loaded file are
applied to “WT Setting” of the software, but not transmitted to the WT.  If the mode is switched from
Off-Line to On-Line, the harmonic measurement conditions is loaded from the WT into the software.

Setup information of specifications, evaluation, etc. .cfg
Same data as those described in “Setup Information” above.

3.9  Loading Setup Information, Measured Data, and Waveform Data
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Left side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt1
Waveform data .bw1

Center of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt2
Waveform data .bw2

Right side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt3
Waveform data .bw3

3.9  Loading Setup Information, Measured Data, and Waveform Data
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Chapter 4 Displaying the Evaluation Results and Measured Data/Waveform Data

4.1 Displaying the Evaluation Results over the
Entire Measurement Time

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.  Below a procedure
is given in which the wiring system of the WT3000 is set to single-phase two-wire (1P2W

) and one input element is used.

1. From the View menu, point to Overall Evaluation Graph then choose

Element1.  The Overall Evaluation Graph (Element 1) window opens.  You can
also choose View > Overall Evaluation Graph > Element1 from the toolbar.

2. Use the scroll bar to set the time zone to be displayed.  The evaluation graph of
the specified time zone is displayed.

Evaluation graph
Of the measured date, the evaluation results over the time span of 150 s are 
displayed.  The bars of each order are displayed using different colors depending 
on the result.  If you change the time zone to be displayed using the display range 
bar, the time zone displayed on the evaluation graph changes accordingly.  The 
time span of the evaluation graph, 150 s, does not change.

Display range bar
Displays the position of the time zone specified with the scroll bar with respect to 
the measurement time.

Scroll bar
Drag the     (slider) or click           to select the time zone you wish to display.  The time 
zone of the evaluation graph changes in sync with the slider position.  Active when the 
measurement time is greater than 150 s.
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Explanation
Evaluation can be made as to whether all of the harmonic measurement data in the
measurement time are within the limits according to the settings specified in section 3.6
“Setting the Standard and Measurement Environment,” and the results can be displayed

collectively.

The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation
of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.

• Overall Evaluation Graph Window

Evaluation graph
Of the measured data, the evaluation results over the time span of 150 s (2.5 
minutes) are displayed.  The bars of each order are displayed using different colors 
depending on the result.  If you change the time zone to be displayed using the 
display range bar, the time zone displayed on the evaluation graph changes 
accordingly.  The time span of the evaluation graph, 150 s, does not change.

Display range bar
Displays the position of the time zone specified with the scroll bar with respect to 
the measurement time.

Scroll bar
Drag the     (slider) or click           to select the time zone you wish to display.  The time 
zone of the evaluation graph changes in sync with the slider position.  Active when the 
measurement time is greater than 150 s.

Number of the input element being 
displayed
In this example, input element 1 is 
being evaluated.

Applicable standard
This software can make evaluations 
according to the IEC or JIS standard.

Class
Indicates the class of equipment as 
specified by the applicable standard.

Judgment
If evaluation of all the data points 
over the measurement time is blue, 
bright green, green, turquoise, or 
aqua as described on the next page, 
PASS is indicated.  If the evaluation 
of any data point is yellow, orange, 
pink, or red, FAIL is indicated.

Fundamental frequency of the PLL 
source (average)
Displays the average fundamental 
frequency of the PLL source of the 
measured data.

Cursor
Click a point within the evaluation graph to move 
the cursor to the data position (time).

Measurement time (setting value)

Measurement timeTime zone of the evaluation graph

Evaluation Colors
The table below describes what the colors in the evaluation graph indicate. Condition
1, Condition 2, 200% short-term relaxation, and POHC relaxation conditions that
appear in the table are defined below.

• Condition 1
The maximum harmonic current over the measurement time is within 1.5 times the

specified limit.  Evaluation is made on each order.

4.1  Displaying the Evaluation Results over the Entire Measurement Time
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• Condition 2
The mean harmonic current over the measurement time is within the specified limit.

Evaluation is made on each order.

• 200% Short-Term Relaxation Conditions
If all of the following conditions are met, up to 200% of the specified limits is permitted.
• The EUT belongs to Class A for harmonics.

• The excursion beyond 150 % of the applicable limits lasts less than 10 % of the
test observation period or in total 10 min (within the test observation period),
whichever is smaller.

• The average value of the harmonic current, taken over the entire test
observation period, is less than 90 % of the applicable limits.

• POHC Relaxation Condition
If the maximum value of the sum of partial odd harmonic currents (POHC) of order

above and including 21 is less than the specified POHC limit, the mean of the odd
harmonic currents of order above and including 21 is permitted to be 1.5 times the
specified limit.

Blue
Both Conditions 1 and 2 are met.  Or, no applicable limits are specified.
(If no applicable limits are specified, white is displayed only for the bar graph display
described in section 4.2.)

Bright green
• Condition 1 is met.
• Condition 2 is not met.
• POHC Relaxation Condition is met.

Yellow
• Condition 1 is met.
• Condition 2 is not met.
• POHC Relaxation Condition is not met.

Green
• Condition 1 is not met.
• Condition 2 is met.
• The 200% short-term relaxation conditions are met.

Orange
• Condition 1 is not met.
• Condition 2 is met.

Pink
• Condition 1 is not met.
• Condition 2 is not met.
• POHC Relaxation Condition is met.

Red
None of the Condition 1, Condition 2, 200% short-term relaxation, or POHC relaxation
conditions is met.

Turquoise
The measured data is less than the larger of the two values, 0.6% of the mean rms current
and 5 mA.

Aqua
• None of the Condition 1, Condition 2, 200% short-term relaxation, or POHC relaxation

conditions is met.
• Excluded from applying the limits because the maximum active power is less than the

minimum power (75 W or 50 W) for applying the limits or set to Infinity.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
evaluation colors.

If the evaluation of all the data points over the measurement time is blue, bright green,
green,  turquoise, or aqua, Judgment on the Overall Evaluation Graph window
indicates PASS.  If the evaluation of any data point is yellow, orange, pink, or red,

Judgment indicates FAIL.

4.1  Displaying the Evaluation Results over the Entire Measurement Time



4-4 IM 761922-02E

Convenient Way of Using the Overall Evaluation Graph
You can select a section of the measured data of interest on the Overall Evaluation

Graph and display the instantaneous values on a bar graph or in a list.  Below is an
example for displaying a bar graph of the harmonic current of input element 1.

1. On the Overall Evaluation Graph, click the section of interest using the mouse.
The cursor moves to the data position (time) that was clicked.

The cursor moves to the position (time) 
where the mouse is pointed and clicked.

Cursor

Displays the cursor
position (time)

2. From the menu, choose View > Harmonic Current Bar Graph > Instant Value
> Element1.  The instantaneous values of the harmonic currents at the cursor
position (time) are displayed on a bar graph.

For a detailed description of the bar graph, see section 4.2.

Displays the time corresponding to the cursor position (time)

The section where the level of the harmonic component of order 4 differs
and the Judgment changes from blue to turquoise

4.1  Displaying the Evaluation Results over the Entire Measurement Time
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4.2 Displaying the Bar Graph of Harmonic Current/
Voltage

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.  Below a procedure
is given in which the wiring system of the WT3000 is set to single-phase two-wire

(1P2W) and one input element is used.

Displaying the Bar Graph of Harmonic Current
From the View menu, point to Harmonic Current Bar Graph then point to
Maximum, Average Value, or Instant Value, and then choose Element1.  The
Harmonic Current Bar Graph (Element 1) window opens.  You can also select

View > Harmonic Current Bar Graph > Maximum, Average Value, or Instant
Value > Element1 from the toolbar.

Display Example: Harmonic Current Instant Bar Graph (Element 1)
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Selecting the Y-Axis (Current Magnitude) Scale
• Selecting the Type of Y-Axis Scale

Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.

When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

• Enabling Percentage Display
Select the Percentage Display check box.  Y-axis scale, THC, POHC, POHC
maximum and POHC limit are displayed in percentages.  The relative harmonic

content of current of each order can be displayed on bar graphs with the
specified fundamental current (fundamental current specified in advance when
making Class C evaluation, see section 3.5) taken to be 100%.

Note
The Percentage Display check box becomes selectable under given conditions.  The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

Displaying the Limits
Select the Limit Value check box.  The limits specified in the applicable
standard are displayed using yellow bars for each order.

Displays the limits using yellow bars

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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Selecting the Instantaneous Values
On the Harmonic Current Instant Bar Graph window, use the scroll bar to select

the instantaneous value to be displayed.

Scroll bar
Drag the     (slider) or click           to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

Displaying the Bar Graph of Harmonic Voltage
From the View menu, point to Harmonic Voltage Bar Graph then point to
Maximum, Average Value, or Instant Value, and then choose Element1.  The

Harmonic Voltage Bar Graph (Element 1) window opens.  You can also select
View > Harmonic Voltage Bar Graph > Maximum, Average Value, or Instant
Value > Element1 from the toolbar.

The operations on the Harmonic Voltage Bar Graph window are the same as the
operations on the Harmonic Current Bar Graph window.  However, because the
voltage does not need to be compared and evaluated against the limit,

operations for percentage display and limit display are not present.  Judgment is
not displayed.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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Explanation
Evaluation can be made as to whether all of the harmonic data in the measurement time are
within the limits according to the settings specified in section 3.5 “Setting the Standard and
Measurement Environment,” and the results can be displayed on bar graphs.

The input element on which harmonic measurement is made varies depending on the wiring
system configuration of the WT (see chapter 8) that you are using.  The evaluation of whether the
results are within the limits of the applicable standard are made by considering all the input
elements specified in the WT wiring system.

Here, explanation is given for the bar graph of harmonic current.  In the case of the bar graph of
harmonic voltage, read “harmonic current” as “harmonic voltage” in the following explanation.
However, because the voltage does not need to be compared and evaluated against the limit,
the explanation of percentage display and limit display are not applicable.

Harmonic Current Bar Graph Window

Scroll bar (not displayed for maximum and average.)
Drag the     (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

Meas Time (not displayed for maximum and average.)
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.2 s) when the first measured data was retrieved.

Window title
The title is "Harmonic Current Maximum Bar Graph" when the window displays the 
maximum values of the harmonic current, "Harmonic Current Average Bar Graph" 
when the window displays the averages, and "Harmonic Current Instant Bar Graph" 
when the instantaneous values.

Displays the limits using yellow bars

Select the Y-axis scale

• Standard
Applicable standard.  This software can make evaluations according to the IEC standard.

• Class
Class of equipment under evaluation Indicates the class of equipment as specified by the
applicable standard.

• Range

Measurement range selected in the WT configuration (see chapter 8).
• Judgment

If evaluation of all the data points over the measurement time is blue, bright green, green,
turquoise, or aqua as described on page 4-3, PASS is indicated.  If the evaluation of any data
point is yellow, orange, pink, or red, FAIL is indicated.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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k = 1

40

U(k)2

U(k):  rms voltage of each order
I(k):   rms current of each order
P(k):  active power of each order
Q(k): reactive power of each order
k: harmonic order 

• Voltage 
 (rms value)

• Current 
 (rms value) 

• Active power • Apparent power

k = 1

40

I(k)2

k = 1

40

P(k) +
k = 1

40 2

P(k)
k = 1

40 2

Q(k)

• Frequency

Fundamental frequency of the PLL source.

• In the case of the Harmonic Current Maximum Bar Graph (or list), the frequency at which

the harmonic current measurement data is maximum within the measurement time

(fundamental frequency of the PLL source) is indicated.

• In the case of the Harmonic Current Average Bar Graph (or list), the average value of all

frequencies (fundamental frequency of the PLL source) within the measurement time is indicated.

• In the case of the Harmonic Current Instant Bar Graph (or list), the frequency of the

individual measurement data point within the measurement time (fundamental frequency

of the PLL source) is indicated.

• PF

× 100
Active power

Apparent power

For multi-phase equipment, the power factor is derived from the active power and apparent

power of all phases.  The computing equation of the active power and apparent power of all

phases varies depending on the wiring system (see the next page).

U(k): rms voltage of each order,  U(1): rms voltage of the fundamental signal
I(k):  rms current of each order,  I(1):  rms current of the fundamental signal
P(k):  active power of each order, P(1):  active power of the fundamental signal
k:  harmonic order

• THC • V THD • A THD • P THD

k = 2

40

I(k)2

k = 2

40

U(k)2

U(1)
× 100 k = 2

40

I(k)2

I(1)
× 100

k = 2

40

P(k)

P(1)
× 100

k = 2

40

Ug(k)2

Ug(1)
× 100 k = 2

40

Usg(k)2

Usg(1)
× 100

Ug(k):  Rms value of the harmonic group of each order
Usg(k):  Rms value of the harmonic subgroup of each order
k:  harmonic order

• V THDG • V THDS

Ig(k):  Rms value of the harmonic group of each order
Isg(k): Rms value of the harmonic subgroup of each order
k:  harmonic order

• A THDG • A THDS

k = 2

40

Ig(k)2

Ig(1)
× 100 k = 2

40

Isg(k)2

Isg(1)
× 100

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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• POHC

Displayed on Instant Bar Graph (or list).

k = 21, 23

39

I(k)2

I(k): rms current of odd harmonics above and including order 21

k: harmonic order, odd value above and including 21

• POHC Max

Displayed on Maximum and Average Bar Graphs (or lists).  POHC maximum derived from

individual measured data points within the measurement time.  If this value is less than the

POHC Limit below, the relaxation condition (see page 4-3) is applied.

• POHC Limit

k = 21, 23

39

IL(k)2

IL(k): Limits of even harmonics above and including 21 as specified by the applicable

standard

k: harmonic order, odd value above and including 21

• Sigma W

The computing equation of the active power of all phases, Sigma W, varies depending on the

wiring system.

WT3000

Wiring System Sigma W Equation Apparent Power of All Phases

1P2W Active power of each input element Apparent power of each input element

1P3W W1+W2 VA1+VA2

3P3W W1+W2 (VA1+VA3) ×  3/2

3V3A W1+W2 (VA1+VA2+VA3)×  3/3

3P4W W1+W2+W3 VA1+VA2+VA3

* W1, W2, and W3 are the active power values displayed in the corresponding position in the
acquisition data window.  VA1, VA2, and VA3 are the apparent power values displayed in the
corresponding position in the acquisition data window.

Note
• When applying the power ratio limit on Class C or D multi-phase equipment, the harmonic

current per watt derived from the total active power (Sigma W) of all phases (three phases if

three-phase) and the power ratio limit are compared and evaluated.

• Equipment whose Sigma W exceeds 600 W is considered Class A equipment under the

standard.  Use caution because the software makes evaluations using the class selected in

standard and measurement environment settings (see section 3.5).

• Set P, Set Fund I, and Set PF

For Set P, the power value (see section 3.5) specified in advance is displayed when making

Class C or D evaluations.

For Set Fund I and Set PF, the fundamental current and power factor values (see section 3.5)

specified in advance are displayed respectively when making Class C evaluations.

Note
If the Percentage Display check box is selected, the Y-axis scale, THC, POHC, POHC

maximum and POHC limit are displayed in percentages.

Displaying the Limits
• If the Limit Value check box is selected, the limits specified in the applicable

standard are displayed using yellow bars for each order.
• The limits are applied only to harmonic current.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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• When limits are specified by the relative harmonic content of order 3 and 5 such as
the limits for Class C equipment with active input power less than or equal to 25 W,

bars of magnitude corresponding to the current values converted from the relative
harmonic content of order 3 and 5 with the fundamental current specified in
advance (see section 3.5) taken to be 100% are displayed.

Bar Graph Type and Displayed Contents
Three types of harmonic current bar graphs are available: maximum bar graph,
average bar graph, and instantaneous bar graph.  The meanings of the displayed

items which vary depending on the bar graph are explained below.
• Items Displayed on the Maximum Bar Graph

• Bar displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement are compared, and the maximum value is displayed.

• Items displayed at the bottom section of the bar graph

The items described on pages 4-8 and 4-10 are displayed.
For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are compared, and the

maximum value is displayed.
• Limit bar

Yellow bars that are 1.5 times the magnitude of the limits specified by the

applicable standard are displayed.
• Items Displayed on the Average Bar Graph

• Bar displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement are averaged, and the average value is displayed.

• Measurement items displayed at the bottom section of the bar graph

The items described on pages 4-8 and 4-10 are displayed.
For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are averaged, and the average

value is displayed.
• Limit bar

Yellow bars that correspond to the magnitude of the limits specified by the

applicable standard are displayed.
• Items Displayed on the Instantaneous Bar Graph

• Bar displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement time are displayed.

• Measurement items displayed at the bottom section of the bar graph

The items described on pages 4-8 and 4-10 are displayed.
Values derived from individual measured data points within the measurement
time are displayed.

• Limit bar
Yellow bars that are 1.5 times the magnitude of the limits specified by the
applicable standard are displayed.

• Instantaneous values
You can use the scroll bar to select the instantaneous values to be displayed.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).
• Selecting the Magnification

When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.
When the type of scale is LOG, you can select *100.0, *10.0, *1.0, or *0.1.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the
measurement range selected in the WT configuration (see chapter 8).  The

maximum value of the LOG scale is one digit above the measurement range,
value that is 10 to an integer power.

• Percentage Display
If the Percentage Display check box is selected, the Y-axis scale, THC, POHC,
POHC maximum and POHC limit can be displayed in percentages.  The relative
harmonic content of current of each order can be displayed on bar graphs with the

specified fundamental current (fundamental current specified in advance when
making Class C evaluation, see section 3.5) taken to be 100%.
• When the magnification of the Y-axis scale is *1.0, the maximum scale of Y-axis

is 100.00%.
• The Percentage Display check box becomes selectable under given conditions.

The Percentage Display check box becomes selectable when the EUT is of

Class C, and ratios are used to evaluate the limits (see section 1.3).
• The percentage display is applied only to harmonic current.
• When limits are specified by the relative harmonic content of order 3 and 5 such

as the limits for Class C equipment with active input power less than or equal to
25 W, bars corresponding to the magnitude of the values are displayed.

Color of Bars
The bar graph that is displayed for each order is displayed using a length converted
from the magnitude of the measured data.  The meaning of the colors is indicated in
the following table.

Blue
Limit not exceeded.

Bright green (applies only to average bar graph)
When the same conditions of bright green on page 4-3 applies.

Green (applies only to maximum bar graph and Instantaneous bar graph)
When the same conditions of green on page 4-3 applies.

Red
Limit exceeded.

White
No applicable limit is specified.
(The bar graph of the fundamental frequency and orders that are not applicable is displayed
in white.)

Yellow
Limit specified by the applicable standard.

Turquoise
The measured data is less than the larger of the two values, 0.6% of the mean rms current
and 5 mA.

Aqua
• Limit exceeded.
• Excluded from applying the limits because the maximum active power is less than the

minimum power (75 W or 50 W) for applying the limits or set to Infinity.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

Bar graphs of harmonic voltage are displayed in white.  Harmonic voltage does not

need to be compared and evaluated against the limit.
Mutual Relationship of Graphs and Lists

When using the scroll bar to select the time of acquisition and displaying the measured data

on a graph window or list window displaying a certain instantaneous value, the other graph
window or list window also shows the measured data at the same time of acquisition.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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4.3 Displaying the List of Harmonic Current/
Voltage

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.  Below a procedure
is given in which the wiring system of the WT3000 is set to single-phase two-wire

(1P2W) and one input element is used.

Displaying the List of Harmonic Current
From the View menu, point to Harmonic Current Measure Value List then
point to Maximum, Average Value, or Instant Value, and then choose
Element1.  The Harmonic Current List (Element 1) window opens.  You can

also select View > Harmonic Current Measure Value List > Maximum,
Average Value, or Instant Value > Element1 from the toolbar.

Display Example: Harmonic Current Instant Value List (Element 1)
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Enabling Percentage Display
Select the Percentage Display check box.  Measured value, limit, THC, POHC,

POHC maximum and POHC limit are displayed in percentages.  The relative
harmonic content of current of each order can be displayed in the Measure and
Limit columns with the specified fundamental current (fundamental current

specified in advance when making Class C evaluation, see section 3.5) taken to
be 100%.

Note
The Percentage Display check box becomes selectable under given conditions.  The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

Selecting the Instantaneous Value
On the Harmonic Current Measure Value List window, you can use the scroll bar
to select the instantaneous values to be displayed.

Scroll bar
Drag the     (slider) or click          to select the instantaneous value 
you wish to display.  Meas Time changes in sync with the slider 
position.

4.3  Displaying the List of Harmonic Current/Voltage
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Displaying the List of Harmonic Voltage
From the View menu, point to Harmonic Voltage Measure Value List then

point to Maximum, Average Value, or Instant Value, and then choose
Element1.  The Harmonic Voltage List (Element 1) window opens.  You can
also select View > Harmonic Voltage Measure Value List > Maximum,

Average Value, or Instant Value > Element1 from the toolbar.

The operations on the Harmonic Voltage List window are the same as the

operations on the Harmonic Current List window.  However, because the
voltage does not need to be compared and evaluated against the limit,
operations for percentage display are not present.  Judgment, limit, and margin

are not displayed.

4.3  Displaying the List of Harmonic Current/Voltage
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Explanation
Evaluation can be made as to whether all of the harmonic data in the measurement time
are within the limits according to the settings specified in section 3.5 “Setting the
Standard and Measurement Environment,” and the results can be displayed in a list.

The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.

Here, explanation is given for the list of harmonic current.  In the case of the list of

harmonic voltage, read “harmonic current” as “harmonic voltage” in the following
explanation.  However, because the voltage does not need to be compared and
evaluated against the limit, the explanation of judgment, percentage display, limit, and

margin are not applicable.

Harmonic Current List Window

Scroll bar (not displayed for maximum and average.)
Drag the     (slider) or click          to select the instantaneous value 
you wish to display.  Meas Time changes in sync with the slider 
position.

Meas Time (not displayed for maximum and average.)
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.20 s) when the first measured data was retrieved.

Window title
The title is "Harmonic Current Maximum List" when the window displays the 
maximum values of the harmonic current, "Harmonic Current Average List" when the 
window displays the averages, and "Harmonic Current Instant List" when the 
instantaneous values.

For a description of the items from Element to Set PF in the list window, see the
explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/Voltage”
(page 4-8).

4.3  Displaying the List of Harmonic Current/Voltage
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Limit
• The limits specified in the applicable standard are displayed in a list for each order.

• The limits are applied only to harmonic current.
• If the Percentage Display check box is selected, the relative harmonic content of

the limit of each order can be displayed with the specified fundamental current

(fundamental current specified in advance when making Class C evaluation, see
section 3.6) taken to be 100%.

• When limits are specified by the relative harmonic content of order 3 and 5 such as

the limits for Class C equipment with active input power less than or equal to 25 W,
the current value converted from the relative harmonic content of order 3 and 5
with the fundamental current specified in advance (see section 3.6) taken to be

100% is displayed.

Margin
Indicates the margin to the limit.  For each order, the margin is derived from the
following equation using the limits and measured values displayed in the list.

× 100
Limit – measured value

Limit

List Type and Displayed Contents
Three types of harmonic current lists are available: maximum list, average list, and

instantaneous list.  The meanings of the displayed items which vary depending on the
list are explained below.

• Items Displayed on the Maximum List
• Measured value displayed for each order

For each order, the individual measured data points (instantaneous values)

within the measurement are compared, and the maximum value is displayed.
• Items displayed in the right column of the list

The items described on pages 4-8 and 4-10 are displayed.

For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are compared, and the
maximum value is displayed.

• Limit
Indicates values that are 1.5 times the limits specified by the applicable
standard.

• Items Displayed on the Average List
• Measured value displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement are averaged, and the average value is displayed.

• Items displayed in the right column of the list

The items described on pages 4-8 and 4-10 are displayed.
For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are averaged, and the average

value is displayed.
• Limit

Indicates the limits specified by the applicable standard.

• Items Displayed on the Instantaneous List
• Measured value displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement time are displayed.

4.3  Displaying the List of Harmonic Current/Voltage
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• Items displayed in the right column of the list
The items described on pages 4-8 and 4-10 are displayed.

Values derived from individual measured data points within the measurement
time are displayed.

• Limit

Indicates values that are 1.5 times the limits specified by the applicable standard.
• Instantaneous values

You can use the scroll bar to select the instantaneous values to be displayed.

Percentage Display
If the Percentage Display check box is selected, the THC, POHC, POHC maximum
and POHC limit can be displayed in percentages.  The relative harmonic content of

the measured value or limit of each order can be displayed with the specified
fundamental current (fundamental current specified in advance when making Class C
evaluation, see section 3.5) taken to be 100%.

• The Percentage Display check box becomes selectable under given conditions.
The Percentage Display check box becomes selectable when the EUT is of Class
C, and ratios are used to evaluate the limits (see section 1.3).

• The percentage display is applied only to harmonic current.
• When limits are specified by the relative harmonic content of order 3 and 5 such as

the limits for Class C equipment with active input power less than or equal to 25 W,

the values are displayed.

Color of Measured Values
The meaning of the colors of the measured values displayed for each order is
indicated in the following table.

Blue
Limit not exceeded.

Bright green (applies only to average list)
When the same conditions of bright green on page 4-3 applies.

Green (applies only to maximum list and Instantaneous list)
When the same conditions of green on page 4-3 applies.

Red
Limit exceeded.

Black
No applicable limit is specified.
(The measured value of the fundamental frequency and orders that are not applicable is
displayed in black.)

Turquoise
The measured data is less than the larger of the two values, 0.6% of the mean rms current and 5 mA.

Aqua
• Limit exceeded.
• Excluded from applying the limits because the maximum active power is less than the

minimum power (75 W or 50 W) for applying the limits or set to Infinity.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

The measured value of harmonic voltage are displayed in black.  Harmonic voltage
does not need to be compared and evaluated against the limit.

Mutual Relationship of Graphs and Lists
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/

Voltage” (page 4-12).

4.3  Displaying the List of Harmonic Current/Voltage
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4.4 Displaying the Bar Graph of the Harmonic
Current Fluctuation

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

Displaying the Harmonic Current Change Graph Window
From the View menu, point to Harmonic Current Fluctuation Graph then
choose Element1.  The Harmonic Current Fluctuation Graph (Element 1)

window opens.  You can also choose View > Harmonic Current Fluctuation
Graph > Element1 from the toolbar.

Display Example: Harmonic Current Fluctuation Graph (Element 1)

Selecting the Order of Current to Be Displayed
From the order selection box, select a value from 1 to 40 or THC.

The maximum number of graph lines that can be displayed is 6.

Order selection box
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Showing/Hiding the Graph
Use the show/hide check box to select whether to show or hide the graph.

Show/Hide check box

Selecting the Y-Axis (Current Magnitude) Scale
• Selecting the Type of Y-Axis Scale

Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.

When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

• Enabling Percentage Display
Select the Percentage Display check box.  The Y-axis scale is displayed in
percentages.  The relative harmonic content of current of each order can be

displayed on graphs with the specified fundamental current (fundamental current
specified in advance when making Class C evaluation, see section 3.5) taken to
be 100%.

Note
The Percentage Display check box becomes selectable under given conditions.  The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

4.4  Displaying the Bar Graph of the Harmonic Current Fluctuation
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Selecting the Time Zone
Use the scroll bar to set the time zone to be displayed.  The harmonic current

fluctuation graph of the specified time zone is displayed.

Scroll bar
Drag the     (slider) or click          to select the time zone you wish to 
display.  The time zone of the graph changes in sync with the slider 
position.

The left end position (time) corresponds to the cursor position (time, 
see page 4-4) of the Overall Evaluation Graph.

Explanation
The harmonic current fluctuation over time can be displayed on graphs.
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The bar graph

can be displayed for each input element of the WT.

Harmonic Current Fluctuation Graph Window

Scroll bar
Drag the     (slider) or click          to select the time zone 
you wish to display.  The time zone of the graph changes in 
sync with the slider position.

Select the Y-axis
scale

Show/Hide check box

Order selection box

4.4  Displaying the Bar Graph of the Harmonic Current Fluctuation
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Selecting the Order
The maximum number of graph lines that can be displayed is 6.  For each graph, you

can select which order of harmonic current to be displayed.
Selectable range: 1 to 40 or THC

Selecting Show/Hide
You can select whether to show or hide each graph.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or

*0.1.
When the scale type is LOG, you can select *100.0, *10.0, *1.0, or *0.1.
• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the

measurement range selected in the WT configuration (see chapter 8).  The
maximum value of the LOG scale is one digit above the measurement range,
and is a value that is an integer power of 10.

• Percentage Display
If you select the Percentage Display check box, the Y-axis scale can be displayed

in percentages.  The change in the relative harmonic content of current of each
order can be displayed on graphs with the specified fundamental current
(fundamental current specified in advance when making Class C evaluation, see

section 3.6) taken to be 100%.
• When the magnification of the Y-axis scale is *1.0, the maximum scale of Y-axis

is 100.00%.

• The Percentage Display check box becomes selectable under given conditions.
The Percentage Display check box becomes selectable when the EUT is of
Class C, and ratios are used to evaluate the limits (see section 1.3).

Color
The colors of the 6 graphs are as follows:

 White,  turquoise,  blue,  bright green,  yellow, and  red.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

Mutual Relationship between the Harmonic Current Change Graph and Measured
Value Judging Graph (see section 4.1)

The left end position (time) of the Harmonic Current Change Graph corresponds to
the cursor position (time, see page 4-4) of the Measured Value Judging Graph.  If you
move the cursor on the Measured Value Judging Graph, the time at the cursor

position becomes the time at the left end of the Harmonic Current Change Graph.

4.4  Displaying the Bar Graph of the Harmonic Current Fluctuation
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4.5 Displaying the Voltage/Current Waveforms

Procedure
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  Below a
procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

The waveform data retrieved immediately before the measurement was stopped in
Harmonic Measurement Mode (see section 3.4) is displayed as voltage or current
waveform on the waveform graph.

Displaying Waveforms
From the View menu, point to Wave Graph then choose Element1.  The

Waveform Graph (Element 1) window opens.  You can also choose View >
Wave Graph > Element1 from the toolbar.

Display Example: Wave Graph (Element 1)

Showing/Hiding Waveforms
Use the show/hide check box to select whether to show or hide the waveform.
The selection can be made for the voltage and current individually.

Show/Hide check box
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Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
Select a value from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and*0.1.

Displaying the Current Value and Phase Angle Using the Cursor
Drag the slider with the mouse to move the cursor.  The current value and
phase angle at the new cursor position are displayed.

The phase angle is the phase difference with respect to the first zero crossing of the

voltage waveform as 0 degrees within the waveform display area.

Slider CursorPhase angle

Current value

Explanation
The waveform data retrieved immediately before the measurement was stopped in Harmonic
Measurement Mode (see section 3.4) is displayed as voltage or current waveform on the
waveform graph.  The bar graph can be displayed for each input element of the WT.  The data is

also different from the data displayed in Harmonic Monitor or Waveform Monitor Mode.  When
evaluating Class C equipment with active input power less than or equal to 25 W using the limits
of the harmonics of order 3 and 5, view the waveform data here and check whether the

relationship of the voltage and current waveforms is within the limits.

Waveform Graph

Slider CursorPhase angle

Current value

First zero crossing point of the voltage waveform

Voltage waveform

Current waveform

Indicates the position of the phase angles of 60, 65, and 90 degrees, which 
are used in the evaluation of Class C equipment with active input power less
than or equal to 25 W.

Select the magnification 
of the Y-axis scale

4.5  Displaying the Voltage/Current Waveforms
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• Element

Number of the input element under evaluation.  In this example, input element 1 is being

displayed.

• Range

Measurement range selected in the WT configuration (see chapter 8).

• Class

Class of the applicable standard.

• Frequency

The average value of all frequencies (frequency of the fundamental signal of the PLL source)

within the measurement time.

• Current Peak (+)

Maximum positive value of the current waveform displayed.

• Current Peak (–)

Maximum negative value of the current waveform displayed.

• Voltage Peak (+)

Maximum positive value of the voltage waveform displayed.

• Voltage Peak (–)

Maximum negative value of the voltage waveform displayed.

Selecting Show/Hide
You can select whether to show or hide the voltage and current individually.

Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
• The scale type is fixed to LIN (linear).  LOG (logarithmic) scale is not supported.

• You can select the magnification from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and *0.1.

Displaying the Current Value and Phase Angle Using the Cursor
When evaluating Class C equipment with active input power less than or equal to 25
W using the limits of the harmonics of order 3 and 5, you can check whether the
relationship of the voltage and current waveforms is within the limits.

• You can display the current value and phase angle at the new cursor position.
• The phase angle is the phase difference with respect to the first zero crossing of

the voltage waveform (0 degrees) within the waveform display area.

• Fixed vertical lines are displayed at the phase angles 60, 65, and 90 degrees used
in the evaluation.  You can check the evaluation conditions (see section 1.3) by
viewing the fixed lines and the current waveform.

Note
If the PLL frequency differs from the voltage frequency being displayed, for the element, the

display may be incorrect since the phase angle value is displayed according to the PLL

frequency.  Measurements should be taken only when the PLL frequency and voltage

frequency are the same.

4.5  Displaying the Voltage/Current Waveforms
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4.6 Displaying the Graph of Voltage, Current, and
Power

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

Displaying the Voltage, Current, and Power Fluctuation Graph
From the View menu, point to Voltage, Current, and Electric Power
Fluctuation Graph, and then choose Element1.  The Voltage, Current, Electric
Power Fluctuation Graph (Element 1) window opens.  You can also choose

View > Voltage, Current, and Electric Power Fluctuation Graph > Element1
from the toolbar.

Display Example: Voltage, Current, and Electric Power Fluctuation Graph
(Element 1)

Showing/Hiding the Graph
Use the show/hide check box to select whether to show or hide the waveform.
Selection can be made for voltage (rms), current (rms), and active power

individually.

Show/Hide check box
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Selecting the Y-Axis (Current Magnitude) Scale
• Selecting the Type of Y-Axis Scale

Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.
When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

Selecting the Time Zone
Use the scroll bar to set the time zone to be displayed.  The voltage, current,
and electric power fluctuation graph of the specified time zone is displayed.

The left end position (time) corresponds to the cursor position (time, 
see page 4-4) of the Overall Evaluation Graph.

Scroll bar
Drag the     (slider) or click          to select the time zone you wish to 
display.  The time zone of the graph changes in sync with the slider 
position.

4.6  Displaying the Graph of Voltage, Current, and Power
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Explanation
The fluctuation of the voltage, current, and power data over time can be displayed on
graphs.  The input element on which harmonic measurement is made varies depending
on the wiring system configuration of the WT (see chapter 8) that you are using.  The bar

graph can be displayed for each input element of the WT.

Voltage, Current, and Electric Power Fluctuation Graph Window

Scroll bar
Drag the     (slider) or click          to select the time zone you wish to 
display.  The time zone of the graph changes in sync with the slider 
position.

Select the Y-axis scale

Show/Hide check box

Selecting Show/Hide
You can select whether to show or hide the voltage (rms), current (rms), and active

power individually.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or
*0.1.

When the scale type is LOG, you can select *100.0, *10.0, *1.0, or *0.1.
• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the

measurement range selected in the WT configuration (see chapter 8).  The

maximum value of the LOG scale is one digit above the measurement range,
and is a value that is an integer power of 10.

4.6  Displaying the Graph of Voltage, Current, and Power
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Color
The colors of the voltage (rms), current (rms), and active power graphs are as follows:

  blue: current (rms),  red: voltage (rms),  dark yellow: active power

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

Mutual Relationship between the Voltage, Current, and Electric Power Fluctuation
Graph and Overall Evaluation Graph (See Section 4.1)

The left end position (time) of the Voltage, Current, and Electric Power Fluctuation
Graph corresponds to the cursor position (time, see page 4-4) of the Overall
Evaluation Graph.  If you move the cursor on the Overall Evaluation Graph, the time

at the cursor position becomes the time at the left end of the Voltage, Current, and
Electric Power Fluctuation Graph.

4.6  Displaying the Graph of Voltage, Current, and Power
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4.7 Displaying the Bar Graph of the Harmonic
Phase Angle

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

Displaying the Bar Graph of the Harmonic Phase Angle
From the View menu, point to Harmonic Phase Angle Bar Graph then choose
Element1.  The Harmonic Phase Angle Bar Graph (Element 1) window opens.

You can also choose View > Harmonic Phase Angle Bar Graph > Element1
from the toolbar.

Display Example: Harmonic Phase Angle Value Bar Graph (Element 1)

Selecting the Instantaneous Value
On the Harmonic Phase Angle Value Bar Graph window, you can use the scroll
bar to select the instantaneous values to be displayed.

Scroll bar
Drag the     (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.
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Explanation
You can display the bar graph of the harmonic phase angle.  The phase angle is not
used to evaluate whether the limits of the applicable standard are met.

The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The bar graph
can be displayed for each input element of the WT.

Harmonic Phase Angle Value Bar Graph Window

Scroll bar
Drag the    (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

Meas Time
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.2 s) when the first measured data was retrieved.

• Bar graphs of the phase angle of the harmonic current with respect to the
fundamental current for each order can be displayed.  However, the phase angle with

respect to the fundamental voltage is displayed on the bar graph for the fundamental
current.
• When the harmonic phase is leading the fundamental current, a positive phase

angle is indicated; when the harmonic phase is lagging the fundamental current, a
negative phase angle is indicated.

• When the fundamental current is leading the fundamental voltage, a negative

phase angle is indicated; when the fundamental current is lagging the fundamental
voltage, a positive phase angle is indicated.

• For a description of the items from Element to Set PF in the bar graph window, see

the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/
Voltage” (page 4-8).  However, because the phase angle does not need to be
compared and evaluated against the limit, the Judgment item is not present.

• Bar graphs of phase angle are displayed in white.

Mutual Relationship of Graphs and Lists
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/
Voltage” (page 4-12).

4.7  Displaying the Bar Graph of the Harmonic Phase Angle
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4.8 Displaying the List of the Harmonic Phase
Angle

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

Displaying the List of the Harmonic Phase Angle
From the View menu, point to Harmonic Phase Angle Measure Value List
then choose Element1.  The Harmonic Phase Angle Value List (Element 1)

window opens.  You can also choose View > Harmonic Phase Angle Measure
Value List > Element1 from the toolbar.

Display Example: Harmonic Phase Angle Measure Value List (Element 1)
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Selecting the Instantaneous Value
On the Harmonic Phase Angle Measure Value List window, you can use the

scroll bar to select the instantaneous values to be displayed.

Scroll bar
Drag the     (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

Explanation
A List of the harmonic phase angles can be displayed.  The phase angle is not used to
evaluate whether the limits of the applicable standard are met.

The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The list can be
displayed for each input element of the WT.

Harmonic Phase Angle Measure Value List Window

Scroll bar
Drag the    (slider) or click          to select the instantaneous value you  
wish to display.  Meas Time changes in sync with the slider position.

Meas Time
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.2 s) when the first measured data was retrieved.

4.8  Displaying the List of the Harmonic Phase Angle
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• A list of the phase angle of the harmonic current with respect to the fundamental
current for each order can be displayed.  However, the phase angle with respect to

the fundamental voltage is displayed in the list for the fundamental current.
• When the harmonic phase is leading the fundamental current, a positive phase

angle is indicated; when the harmonic phase is lagging the fundamental current, a

negative phase angle is indicated.
• When the fundament current is leading the fundamental voltage, a negative phase

angle is indicated; when the fundamental current is lagging the fundamental

voltage, a positive phase angle is indicated.
• For a description of the items from Element to Set PF in the list window, see the

explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/Voltage”

(page 4-8).  However, because the phase angle does not need to be compared and
evaluated against the limit, the Judgment item is not present.

Mutual Relationship of Graphs and Lists
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/
Voltage” (page 4-12).

4.8  Displaying the List of the Harmonic Phase Angle
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4.9 Displaying the Time Analysis Graph of
Relaxation Condition

Procedure
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using. Below a
procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

• Displaying the Relaxation Period Analysis Graph Window
From the View menu, point to Time Analysis Graph of Relaxation Condition,

and choose Element1. The Time Analysis Graph of Relaxation
Condition(Element1) window opens. You can also choose View > Time
Analysis Graph of Relaxation Condition > Element1 from the toolbar.

Display Example: Time Analysis Graph of Relaxation Condition (Element1)

• Selecting the Order of Current to Be Displayed
From the order selection box, select a value from 1 to 40.
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• Selecting the Y-Axis (Current Magnitude) Scale
• Selecting the Type of Y-Axis Scale

Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.

When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

• Selecting the Time Zone
Use the scroll bar to set the time zone to be displayed. The time analysis graph
of relaxation condition of the specified time zone is displayed.

Scroll bar
Drag the     (slider) or click          to select the time zone you wish to 
display.  The time zone of the graph changes in sync with the slider 
position.

The left end position (time) corresponds to the cursor position (time, 
see page 4-4) of the Overall Evaluation Graph.

4.9  Displaying the Time Analysis Graph of Relaxation Condition
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Explanation
If the class was set to A according to the procedure in section 3.5, you can display a
graph that analyzes the period during which harmonic currents exceed 150% of the
applicable limits.

The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using. A bar graph
can be displayed for each input element of the WT.

• Time Analysis Graph of Relaxation Condition

Scroll bar
Drag the     (slider) or click          to select the time zone 
you wish to display.  The time zone of the graph changes in 
sync with the slider position.

Select the Y-axis scale

Total period during which measured values exceed
150% of the limit.
This value turns red when it exceeds the period during
which the measured values are permitted to exceed 150%.

Order selection box

10% of the test observation period or 10 minutes, 
whichever is smaller.

The area in which the measured values exceed
150% of the limit appears in pink.

150% of the
limit specified
in the applicable
standard

Measured
values

Note
If the class is set to B, C, or D, the graph operates as follows:

• It does not display the yellow line that indicates the 150% limit.

• It does not fill the area in which the measured values exceed 150% of the limit in pink.

• It displays “...” for Beyond 150% Total Time and for Beyond 150% Limit Time.

4.9  Displaying the Time Analysis Graph of Relaxation Condition
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• Selecting the Order
You can select which order of harmonic current to be displayed.

Selectable range: 1 to 40

Note
If you set the order to 1, there is no limit, and the graph operates as follows:

• It does not display the yellow line that indicates the 150% limit.

• It does not fill the area in which the measured values exceed 150% of the limit in pink.

• It displays “...” for Beyond 150% Total Time and for Beyond 150% Limit Time.

• Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or
*0.1.

When the scale type is LOG, you can select *100.0, *10.0, *1.0, or *0.1.
• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the

measurement range selected in the WT configuration (see chapter 8). The

maximum value of the LOG scale is one digit above the measurement range,
and is a value that is an integer power of 10.

Yellow
150% of the limit specified in the applicable standard.

Bright green
Measured values.

Pink
Area in which the measured values exceed 150% of the limit.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

• Mutual Relationship between the Harmonic Current Change Graph and
Measured Value Judging Graph (see section 4.1)
The left end position (time) of the Harmonic Current Change Graph corresponds to

the cursor position (time, see page 4-4) of the Measured Value Judging Graph. If you
move the cursor on the Measured Value Judging Graph, the time at the cursor
position becomes the time at the left end of the Harmonic Current Change Graph.

4.9  Displaying the Time Analysis Graph of Relaxation Condition
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Chapter 5 Harmonic Monitor and Waveform Monitor

5.1 Monitoring Harmonics

Procedure
The input element on which harmonic monitor is performed varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using. Below a
procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

To select the Harmonic Monitor mode used to monitor the fluctuation of the
harmonics while making measurements on the WT, you must set the
communication mode to On-Line (see section 3.2).

Selecting the Harmonic Monitor Mode
1. From the Setting menu, choose Measurement Mode.The Measurement mode

setup dialog box opens.  You can also click  on the toolbar. The Measureme

2. Choose Harmonic Monitor. The Harmonic Monitor window appears.

Display Example: Harmonic Monitor Window

Note
When you switch the measurement mode, all the data retrieved and loaded up to that point

are cleared. It is recommended that the data retrieved using Harmonic Measurement Mode

be saved (see section 6.1) before changing the measurement mode.
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Starting/Stopping the Monitor Operation
• Starting the Monitor Operation

Click Start. The monitor operation starts.

• Stopping the Monitor Operation
Click Stop. The monitor operation stops.

Selecting the Monitored Contents
• Selecting Bar or List

Select Graph View (bar graph) or List View (list).

• Selecting Current, Voltage, or Phase Angle
Select A (current), V (voltage), or Deg (phase angle).

• Selecting the Input Element
Select the input element to be monitored.

The input element on which harmonic monitor is performed varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.

• Selecting the Type of Y-Axis Scale
Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification of the Y-Axis Scale
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.
When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

5.1  Monitoring Harmonics
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• Setting the Y-Axis Scale to Percentage Display
Select the Percentage Display check box. The Y-axis scale is displayed in

percentages. The relative harmonic content of current of each order can be
displayed on graphs with the specified fundamental current (fundamental current
specified in advance when making Class C evaluation, see section 3.5) taken to

be 100%.

Note
The Percentage Display check box becomes selectable under given conditions. The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

• Displaying the Limits
Select the Limit Value check box. The limits specified in the applicable standard
are displayed using yellow bars for each order.

The operation of the limit display is selectable only when the monitored item is current.

Displays the limits using yellow bars

• Displaying the Harmonic, Harmonic Group, and Harmonic Subgroup
Select the Harmonic, Harmonic Groups, and Harmonic Subgroups check

boxes. The measured value of each measurement item is shown using a bar
graph.

5.1  Monitoring Harmonics
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• Displaying the Interharmonic Group and Interharmonic Subgroup
Select the Interharmonic Groups and Harmonic Subgroups check boxes. The

measured value of each measurement item is shown using a bar graph.

Clear the interharmonic group and interharmonic subgroup displays

5.1  Monitoring Harmonics
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Explanation
The Harmonic Monitor mode is selectable only when in On-Line mode. Harmonic
fluctuation can be monitored on bar graphs and numerical lists while making harmonic
measurements on the WT. This mode is used to monitor the conditions of the harmonics

and does not evaluate against the standard as in Harmonic Measurement Mode. When
the next measured data is retrieved, the previous measured data is updated and does
not remain.

The input element on which harmonic monitor is performed varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using. The harmonics

can be monitored for each input element of WT.

Harmonic Monitor Window (Bar Graph)
The figure below shows a bar graph example.

Displays the limits using yellow bars
Clear the harmonic, harmonic group, harmonic subgroup, and limit displays

Select the Y-axis scale

Select bar graph or list

Select the voltage, current, and phase angle
Select the input element

Clear the interharmonic group and interharmonic center subgroup displays

• You can monitor the bar graph or list of the voltage, current, or phase angle for each
order.

• When monitoring the current, the limits of the applicable standard can be
displayed. When monitoring the voltage or phase angle, the limits are not
displayed, because the voltage or phase angle does not need to be compared

against the limits.
• The concept of the phase angle reference is the same as the explanation given in

section 4.7, “Displaying the Bar Graph of the Harmonic Phase Angle” (page 4-31).

• For a description of the items from Class to Set PF in the window, see the explanation
in section 4.2, “Displaying the Bar Graph of Harmonic Current/Voltage” (page 4-8).
However, Standard, Judgment, and Element items are not present.

5.1  Monitoring Harmonics



5-6 IM 761922-02E

Color of Bars
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/

Voltage” (page 4-12). Bright green and green are not available.

• Color of the Harmonic Group and Harmonic Subgroup of Current
The harmonic, harmonic group, and harmonic subgroup are superimposed on the

bar graph.
• When the Measured Values Are within the Limit

Bar graph of the harmonic group 
(deep blue)

Bar graph of the harmonic subgroup 
(ultramarine blue)

Bar graph of the harmonic 
(blue)

• When Evaluation Is Not Made Because the Measured Data Is Less than the
Larger of the Two Values, 0.6% of the Mean Rms Current and 5 mA

Bar graph of the harmonic group (dark green)

Bar graph of the harmonic subgroup (aqua)

Bar graph of the harmonic (turquoise)

• Color of the Harmonic Group and Harmonic Subgroup of Voltage
The harmonic, harmonic group, and harmonic subgroup are displayed as shown

below. There is no need to compare with the limit to make evaluations.

Bar graph of the harmonic group (dark gray)

Bar graph of the harmonic subgroup (gray)

Bar graph of the harmonic (white)

• Color of the Interharmonic Group and Interharmonic Center Subgroup
The interharmonic group and interharmonic center subgroup are displayed as
shown below. There is no need to compare with the limit to make evaluations.

Bar graph of the interharmonic center 
subgroup (white)

Bar graph of the interharmonic group 
(dark gray)

5.1  Monitoring Harmonics
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Color of Phase Angles
Bar graphs of phase angle are displayed in white. The values displayed in the list are

black.

Displaying the Limits
Comparison and evaluation are not made against the limits in Harmonic Monitor
mode. The limits specified by the applicable standard are displayed for reference.
Since the harmonic data monitored in the Harmonic Monitor mode is an instantaneous

value, the values (list) and yellow bars (bar graph) of the limits are 1.5 times the actual
limits.
• If the Limit Value check box is selected, the limits are displayed using values or

yellow bars for each order.
• The limits are displayed only for harmonic current.
• When limits are specified by the relative harmonic content of order 3 and 5 such as

the limits for Class C equipment with active input power less than or equal to 25 W,
bars of magnitude corresponding to the current values converted from the relative
harmonic content of order 3 and 5 with the fundamental current specified in

advance (see section 3.6) taken to be 100% are displayed.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or
*0.1.

When the scale type is LOG, you can select *100.0, *10.0, *1.0, or *0.1.
• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the

measurement range selected in the WT configuration (see chapter 8). The

maximum value of the LOG scale is one digit above the measurement range,
and is a value that is an integer power of 10.

• Percentage Display
If you select the Percentage Display check box, the Y-axis scale, THC, and POHC
can be displayed in percentages. The relative harmonic content of current of each

order can be displayed on bar graphs or lists with the specified fundamental current
(fundamental current specified in advance when making Class C evaluation, see
section 3.6) taken to be 100%.

• When the magnification of the Y-axis scale is *1.0, the maximum scale of Y-axis
is 100.00%.

• The Percentage Display check box becomes selectable under given conditions.

The Percentage Display check box becomes selectable when the EUT is of
Class C, and ratios are used to evaluate the limits (see section 1.3).

• The percentage display is applied only to harmonic current.

• When limits are specified by the relative harmonic content of order 3 and 5 such
as the limits for Class C equipment with active input power less than or equal to
25 W, bars corresponding to the magnitude of the values are displayed on the

bar graph or the values are displayed in the list.

5.1  Monitoring Harmonics
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Harmonic Monitor Window (List)

Interharmonic center subgroup
Interharmonic group

Harmonic subgroup
Harmonic group

Harmonics

Color of Measured Values Displayed in the List
See the explanation in section 4.3, “List Display of Harmonic Current/Voltage” (page4-
18). Bright green and green are not available.

5.1  Monitoring Harmonics
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5.2 Monitoring Waveforms

Procedure
The input element on which waveform monitor is performed varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  Below a
procedure is given in which the wiring system of the WT3000 is set to single-phase two-
wire (1P2W) and one input element is used.

To select the Waveform Monitor mode used to monitor the waveforms while
making measurements on the WT, you must set the communication mode to
On-Line (see section 3.2).

Selecting the Waveform Monitor Mode
1. From the Setting menu, choose Measurement Mode.  The Measurement mode

setup dialog box opens.  You can also click  on the toolbar.

2. Choose Waveform Monitor.  The Waveform Monitor window opens.

Display Example: Waveform Monitor Window

Note
When you switch the measurement mode, all the data retrieved and loaded up to that point is

cleared.  It is recommended that the data retrieved using Harmonic Measurement Mode be

saved (see section 6.1) before changing the measurement mode.
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Starting/Stopping the Monitor Operation
• Starting the Monitor Operation

Click Start.  The monitor operation starts.

• Stopping the Monitor Operation
Click Stop.  The monitor operation stops.

Showing/Hiding Waveforms
Use the show/hide check box to select whether to show or hide the waveform.
The selection can be made for the voltage and current individually.

Show/Hide check box

Voltage (V1) and 
current (A1) of input 
element 1

Voltage (V2) and 
current (A2) of input 
element 2

Voltage (V3) and 
current (A3) of input 
element 3

Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
Select a value from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and*0.1.

5.2  Monitoring Waveforms
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Explanation
The Waveform Monitor mode is selectable only when in On-Line mode.  The measured
waveform can be monitored while making harmonic measurements on the WT.  This
mode is used to monitor the conditions of the waveform and does not evaluate against

the standard as in Harmonic Measurement Mode.  When the next waveform data is
retrieved, the previous waveform data is updated and does not remain.

The input element on which waveform monitor is performed varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The
waveforms of relevant input elements can be monitored simultaneously.

Waveform Monitor Window

Voltage waveform

Current waveform

Select the magnification of the Y-axis scale

• Element

The number of the input element under observation.  In this example, input element 1 is

under observation.

• Range

Measurement range selected in the WT configuration (see chapter 8).

Selecting Show/Hide
You can select whether to show or hide the voltage and current individually for each
input element.

Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
• The scale type is fixed to LIN (linear).  LOG (logarithmic) scale is not supported.

• You can select the magnification from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and *0.1.
• Waveforms are displayed with the measurement range selected in the WT Setting

(chapter 8) is taken to be the maximum value (1.0) of the Y-axis scale

Color
The colors below are assigned in ascending order of input element number for which
the waveform is monitored. For example, the colors of voltage/current waveforms are

assigned as follows when the waveforms a wiring unit consisting of input elements 1,
2, and 3 are monitored:

Element Voltage Current

Input element 1  Pink Bright green

Input element 2 Blue  Yellow

Input element 3 Turquoise Red

* The names of the sample colors of Microsoft Word or Excel are used for the names of the colors.

5.2  Monitoring Waveforms
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Chapter 6 Loading/Saving Data and Repeatability of Measured Data

6.1 Saving Setup Information, Measured Data, and
Waveform Data

Procedure
Note

• Setup information, measured data, or waveform data cannot be saved when the

measurement mode is set to Harmonic Monitor or Waveform Monitor or when no setup

information, measured data, or waveform data is present.

• Setup information, measured data, and waveform data cannot be saved while measurement

is in progress.

Saving Setup Information
1. From the File menu, point to Save, then choose Save Setup Information.  The

Save As dialog box opens.  You can also select Save Setup Information from
the Save icon on the toolbar.

2. After setting the Save in box, enter the name of the file you wish to save in the
File name entry box.

3. Click Save.  The setup information is saved.
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Saving Measured Data, Waveform Data, or Setup Information
When the measurement mode is set to Harmonic Measurement and the measured

data or waveform data has been retrieved (or loaded), the measured data or
waveform data can be saved.
1. From the File menu, point to Save, then choose Save Measure Data.  The

Save As dialog box opens.  You can also select Save Measure Data from the
Save icon on the toolbar.

2. After setting the Save in box, enter the name of the file you wish to save in the
File name entry box.

3. Click Save.  Measured data, waveform data, or setup information is saved.

6.1  Saving Setup Information, Measured Data, and Waveform Data
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Explanation
Saving Setup Information

Various setup information configured using the software including the measurement
mode (see section 3.4), standard and measurement environment settings (see section

3.5), measurement time (see section 3.6), display settings (chapters 4 and 5), title/
comment of reports (see section 7.2) can be saved to a file.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .cfg

• Data size: Approx. 3 KB

Saving Measured Data, Waveform Data, or Setup Information
• The harmonic measurement data or waveform data retrieved from the WT in

Harmonic Measurement mode into the PC using the software can be saved to a
file.  In this case, the harmonic measurement conditions of the WT specified using

the software and setup information described above are also saved.
• When the measurement mode is set to Harmonic Measurement and the measured

data or waveform data has been retrieved (or loaded), the measured data or

waveform data can be saved.

File Name, Extension, and Data Size
• The file name can be any legal file name as defined by the PC that you are using.
• When the save operation is executed, all the files with the extensions shown in the

following table are created using the same file name.

• The extensions .bt1 to .bt3 and .bw1 to .bw3 below are assigned in ascending
order of input element number for which the harmonics are measured.
For example, the file name extension and measured data correspond as shown

below when the harmonics of a wiring unit consisting of input elements 1, 2, and 3
are measured.

• Even when only the measured data or waveform data of input element 1 is present,

the files with extensions .bt1 to 4, .bw1 to 3, .inf, and .cfg are created. However, in
such cases, data corresponding to zero is saved in the .bt2 to 4 and .bw2 to 3 files.

Data Type Extension Data Size (Bytes)

Measured data of input element 1 .bt1 Approx. 400 K (when the
measurement time is 2 min. 30 s)

Measured data of input element 2 .bt2 Approx. 400 K (when the
measurement time is 2 min. 30 s)

Measured data of input element 3 .bt3 Approx. 400 K (when the
measurement time is 2 min. 30 s)

Measured data common to all input elements .bt4 Approx. 18 K (when the
measurement time is 2 min. 30 s)

Waveform data of input element 1 .bw1 Approx. 18K
Data displayed as voltage/current waveforms (see section 4.5).

Waveform data of input element 2 .bw2 Approx. 18K
Data displayed as voltage/current waveforms.

Waveform data of input element 3 .bw3 Approx. 18K
Data displayed as voltage/current waveforms.

Harmonic measurement conditions of the WT .inf Approx. 2K
For details on the measurement conditions, see chapter 8.

Setup information of specifications, .cfg Approx. 3K
evaluation, etc.

Same data as those described in “Saving Setup Information” above.

6.1  Saving Setup Information, Measured Data, and Waveform Data
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6.2 Loading Setup Information, Measured Data,
and Waveform Data

Procedure
Note

• Setup information, measured data, and waveform data cannot be loaded when the

measurement mode is set to Harmonic Monitor or Waveform Monitor.

• If an error occurs while loading the setup information, the settings are reset to their default

values.

• If an error occurs while loading setup information, measured data, or waveform data, the data

may not be loaded properly.  Check the file name and extension, and load the data again.

• Setup information, measured data, and waveform data cannot be loaded while measurement

is in progress.

Loading Setup Information
1. From the File menu, point to Load then choose Load Setup Information.  The

Open dialog box opens.  You can also select Load Setup Information from the
Load icon on the toolbar.

2. Select a file name and click Open.  The setup information of the selected file is
loaded.

Loading Measured Data, Waveform Data, and Setup Information
Measured data, waveform data, and setup information can be loaded when the
measurement mode is set to Harmonic Measurement.

1. From the File menu, point to Load, and then choose Load Measure Data.  The
Open dialog box opens.  You can also select Load Measure Data from the
Load icon on the toolbar.
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2. Select a file name and click Open.  The measured data, waveform data, or
setup information of the selected file is loaded.

Explanation
Loading Setup Information

The setup information saved in section 6.1 can be loaded.
• The extension of the loaded file is .cfg.
• The contents of the setup information are as follows:

• Measurement mode (see section 3.4 ).
• Standard and measurement environment settings (see section 3.5).

The measurement data retrieved from the WT or loaded from a file can be

evaluated using the loaded evaluation conditions.
• Measurement time (see section 3.6).
• Display settings (chapters 4 and 5).

• Title/Comment of Reports (see section 7.2).
Reports of measurement data retrieved from the WT or loaded from a file can be
saved or printed by attaching the loaded title or comment.  For the saving and
printing procedure, see chapter 7.

Loading Measured Data, Waveform Data, and Setup Information
• The measurement data, waveform data, and setup information saved in section 6.1

can be loaded.
• Measured data can be loaded when the measurement mode is set to Harmonic

Measurement.

• When one of the files with .bt1, .bt2, .bt3, and .bt4 extension is selected in the
Open dialog box and loaded, the data of all the files with the same file name in the
same directory is loaded. See the table on the next page.

6.2  Loading Setup Information, Measured Data, and Waveform Data



6-6 IM 761922-02E

Data Type Extension

WT3000 Measured data on the left side of the acquisition data window .bt1

Measured data in the center of the acquisition data window .bt2

Measured data on the right of the acquisition data window .bt3

Measured data common to all input elements .bt4

Waveform data on the left side of the acquisition data window .bw1

Waveform data in the center of the acquisition data window .bw2

Waveform data on the right side of the acquisition data window .bw3

Harmonic measurement conditions of the WT .inf
• If the communication mode is On-Line, the harmonic measurement conditions of the loaded

file are applied to “WT Setting” (chapter 8) of the software and transmitted to the WT.  If the
transmitted harmonic measurement conditions do not match the configuration of the WT, an
error message appears.  Check the configuration of the connected WT.

• If the communication mode is Off-Line, the harmonic measurement conditions of the loaded file are
applied to “WT Setting” of the software, but not transmitted to the WT.  If the mode is switched from
Off-Line to On-Line, the harmonic measurement conditions is loaded from the WT into the software.

Setup information of specifications, evaluation, etc. .cfg
Same data as those described in “Setup Information” above.

Left side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt1
Waveform data .bw1

Center of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt2
Waveform data .bw2

Right side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt3
Waveform data .bw3

6.2  Loading Setup Information, Measured Data, and Waveform Data
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6.3 Saving Harmonic Measurement Data in CSV
Format

Procedure
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), the harmonic measurement data can be saved in

CSV format.

Note
• Harmonic measurement data cannot be saved in CSV format when the measurement mode

is set to Harmonic Monitor or Waveform Monitor or when no measured data is present.

• Harmonic measurement data cannot be saved in CSV format when measurement is in

progress.

1. From the File menu, point to Save, then choose Save Harmonic Data (CSV).
The Save As dialog box opens.  You can also select Save Harmonic Data
(CSV) from the Save icon on the toolbar.

Selecting the Data to Be Saved
2. Select Current or Voltage.

3. Select the Element (input element).
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,

input element to be saved also varies.

4. After selecting a folder in the Save in box, enter the name of the file you wish to
save in the File name box.

5. Click Save.  The harmonic measurement data is saved in CSV format.
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Explanation
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), the harmonic measurement data can be saved in
CSV format.  A file in CSV format can be opened using a spreadsheet application (such

as Microsoft Excel) on your PC.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .csv
• Data size: Approx. 300 K (when the measurement time is 2 min. 30 s)

Example When the Harmonic Measurement Data Saved in CSV Format Is Opened
Using Excel

Date/Time the
file was saved

Data being measured
Current in this example.

Input element being measured
Element 1 in this example.

Order

S
am

p
le C

o
u

n
t n

u
m

b
er

Harmonic measurement values

6.3  Saving Harmonic Measurement Data in CSV Format
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6.4 Saving Waveform Data in CSV Format

Procedure
When the measurement mode is set to Harmonic Measurement and the waveform

data has been retrieved (or loaded), the waveform data can be saved in CSV format.

Note
• Waveform data cannot be saved in CSV format when the measurement mode is set to

Harmonic Monitor or Waveform Monitor or when waveform data in Harmonic Measurement

Mode is not present.

• Waveform data cannot be saved in CSV format when measurement is in progress.

1. From the File menu, point to Save, then choose Save Wave Data (CSV).  The

Save As dialog box opens.  You can also select Save Wave Data from the Save
icon on the toolbar.

Selecting the Data to Be Saved
2. Select Current or Voltage.

3. Select the Element (input element).
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,

input element to be saved also varies.

4. After selecting a folder in the Save in box, enter the name of the file you wish to
save in the File name box.

5. Click Save.  The waveform data is saved in CSV format.
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Explanation
When the measurement mode is set to Harmonic Measurement and the waveform data
has been retrieved (or loaded), the waveform data can be saved in CSV format.  A file in
CSV format can be opened using a spreadsheet application (such as Microsoft Excel) on

your PC.
• The data that is saved is the waveform data that is retrieved immediately after the

measurement is finished with the measurement mode set to Harmonic Measurement.

• The waveform data (approximately 2 periods) is expressed using 2200 data points.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .csv
• Data size: Approx. 40 KB

Example When the Waveform Data Saved in CSV Format Is Opened Using Excel

Date/Time the
file was saved

Data being measured
Current in this example.

Input element being measured
Element 1 in this example.

N
u

m
b

er o
f w

avefo
rm

 d
ata p

o
in

ts (u
p

 to
 2200)

W
avefo

rm
 d

ata valu
es

C
urrent in this exam

ple.

6.4  Saving Waveform Data in CSV Format
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6.5 Checking the Repeatability of the Measured
Data

Procedure
Note

You cannot check the repeatability of the waveform data while measurement is in progress.

1. From the File menu, choose Repeatability of Measured Data.  The-

Repeatability of Measurement Data dialog box opens.

2. Click the file to be compared or enter the name of the file to be compared in the

File name box.
3. Click Open.  The file shown in the File name text box is displayed in the list of

files to be compared.

4. Repeat steps 2 and 3 to select all the files to be compared.
5. Click Exec.  Repeatability of Measurement Data window opens.

• For multi-phase equipment, it is recommended that files of the same input element

(same phase) be selected and the data be compared.  The repeatability cannot be

evaluated correctly when using measured data of different phases.

• Even if only one file is selected, the Repeatability of Measurement Data window will

open.  In this case, no comparison is made.

Files to be compared
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Example of Comparison: The difference at order 26 exceeds 5%.
Order 26 component

6.5  Checking the Repeatability of the Measured Data
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Explanation
The mean value in the harmonics measurement data saved to files can be compared,
and the difference in the measured data can be displayed on a bar graph and list for
each order.  This function can be used to evaluate whether the difference between data

measured under the same measurement conditions when harmonics are measured
using the same product or same product model is within 5% of the limits (confirmation of
repeatability).

Repeatability of Measurement Data Window
The following figure shows an example of comparison.

Average

+5% line

–5% line–Max Error
(yellow)

+Max Error
(blue)

Red when the 5% line is exceeded

B
ar g

rap
h

 d
isp

lay
L

ist d
isp

lay

Maximum (Mnmax)

Maximum value among the average values of each order

Minimum (Mnmin)

Minimum value among the average values of each order

Average (Mnmean)

Average of the average values of each order of the selected file

+Max Error

Ratio (%) of the difference between Mnmax and Mnmean of each order

Mnmax – Mnmean
Mnmean

× 100

–Max Error

Ratio (%) of the difference between Mnmin and Mnmean of each order

Mnmin – Mnmean
Mnmean

× 100

6.5  Checking the Repeatability of the Measured Data
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Color
• Bar Graph

The bar graph that is displayed for each order is displayed using a length
converted from the +Max Error or –Max Error.  The meaning of the colors is
indicated in the following table.

Blue
Difference (error) less than the +5% line for +Max Error.

Yellow
Difference (error) less than the –5% line for –Max Error.

Red
Difference (error) greater than the +5% line for +Max Error.
Difference (error) greater than the –5% line for –Max Error.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

• List
The average, limit, +maximum error, and –maximum error for each order are

displayed using values in black.

Number of Files That Can Be Compared
To evaluate the repeatability of the measured data, multiple files must be selected.
Number of files that can be compared: 2 to 10

Note
• For multi-phase equipment, it is recommended that files of the same input element (same

phase) be selected and the data be compared.  The repeatability cannot be evaluated

correctly when using measured data of different phases.

• Even if only one file is selected, the Repeatability of Measurement Data window will open.  In

this case, no comparison is made.

• To evaluate the repeatability, check that the measured data saved to the file to be compared

was measured under the following conditions.

• Same DUT (not the same model, but the same equipment).

• Same test conditions.

• Same test equipment.

• Same atmospheric conditions (when the DUT is affected by them).

6.5  Checking the Repeatability of the Measured Data
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Chapter 7 Saving/Printing Screen Images and Reports

7.1 Saving Screen Image Data in BMP Format

Procedure
1. From the File menu, point to Save, then choose Save Display Image (BMP).

The Save As dialog box opens.  You can also select Save Display Image from
the Save icon on the toolbar.

2. After selecting a folder in the Save in box, enter the name of the file you wish to

save in the File name box.
3. Click Save.  The screen image data that is present when Save is clicked is

saved to a file in BMP format.
If you attempt to save the file using an existing file name, an overwrite warning

message appears.  In this case, the screen image data that is present when Yes is

clicked is saved to a file in BMP format.
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Explanation
The screen image data of an active window such as acquisition data, bar graph, list, and
waveform windows can be saved to a file in BMP format.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .bmp

• Data size: Approx. 2.5 MB maximum.  The data size varies depending on the
window being saved and the display setting of your PC.

Example When the Saved Screen Image Data Is Inserted in a Word Processor
Application (Such as Microsoft Word)

Note
You may not be able to open the BMP file saved using the software depending on the image

processing software.

7.1  Saving Screen Image Data in BMP Format
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7.2 Setting Titles/Comments of Reports and
Saving Reports in BMP Format

Procedure
Note

• Reports cannot be saved in BMP format when the measurement mode is set to Harmonic

Monitor or Waveform Monitor or when no measured data or waveform data is present.

• You cannot set the title/comment of reports or save reports to BMP format while

measurement is in progress.

Setting the Title/Comment of Reports
1. From the Setting menu, choose Report Setup.  The Report Setup dialog box

opens.  You can also choose Report Setup from the Setup icon on the toolbar.

2. Enter appropriate text in the Report Title and Report Comment text boxes.
3. Select Color or Mono for the print mode.

4. Click OK.

Saving Reports in BMP Format
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), reports can be saved in BMP format.
1. From the File menu, point to Save, then choose Save Report (BMP).  The

Save Report File dialog box opens.  You can also select Save Report from the
Save icon on the toolbar.
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• Selecting the Data for Creating the Report and Setting the Save Destination
of the Report

2. Select the Element (input element).
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,

the selectable input element to be saved also varies.

3. Select the Average, Maximum, or Wave check box to select the data for
creating the report.
• You can select multiple items.

• The Wave check box becomes selectable only for Class C equipment with active input

power less than or equal to 25 W, because the waveform data is used for evaluation

only in this case.

4. Check the save destination of the report selected in step 3.  To change the save
destination, click File on the same line.  The Save As dialog box opens.

5. After selecting a folder in the Save in box, enter the name of the file you wish to
save in the File name box.

6. Click Save.  The screen returns to the Save Report File dialog box.
7. Repeat steps 4 to 6 to set the save destination of all reports to be created.

• Executing the Save Operation
8. Click OK.

7.2  Setting Titles/Comments of Reports and Saving Reports in BMP Format
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Explanation
Reports can be created and saved to BMP format using the data measured by the
software.

Setting the Title/Comment of Reports
As necessary, you can enter a title and comment of the report that are saved along
with the report when the report is saved to BMP format.

• Number of Characters That Can Be Entered
See the table below.

Item Number of Characters That Can Be Entered

Title Up to 50 characters.

Comment Up to 50 characters.

• Print Mode
You can select whether to print the report in color or in black and white.  To print
the bar graph using different colors, it is recommended that the printing be done in

color.  For a description of the print preview and print procedure, see sections 7.4
and 7.5, respectively.

Saving the Report in BMP Format
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), reports can be saved in BMP format.

• Selecting the Data for Creating Reports
Reports can be created for each input element.  The print preview (see section 7.4)
of the report can be displayed using the software.  The saved report can also be

inserted into a word processing (such as Microsoft Word) document to be
displayed or printed (see sections 7.3 to 7.5).
• You can select average, maximum, and/or waveform data for creating the

report.
• You can select multiple items.
• The Wave check box becomes selectable only for Class C equipment with

active input power less than or equal to 25 W, because the waveform data is
used for evaluation only in this case.

* Average: Average of the individual data points (instantaneous values) within the

measurement time for each order.

Maximum: The maximum value among the individual data points (instantaneous

values) within the measurement time for each order.

• The input element on which harmonic measurement is made varies depending

on the wiring system configuration of the WT that you are using (see chapter 8).
Therefore, the selectable input element to be saved also varies.

• Saving the Report
The title/comment (see above) entered in advance can be saved along with the
report.  When saving the average, maximum, and wave reports, assign a separate

name for each report.

• File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .bmp
• Data size: Approx. 2.5 MB maximum.  The data size varies depending on the

window being saved and the display setting of your PC.

7.2  Setting Titles/Comments of Reports and Saving Reports in BMP Format
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Example When the Saved Report (Average) Is Loaded to a Word Processor
Application (Such as Microsoft Word)

For a description of the items displayed in the report, see section 1.6.

Note
You may not be able to open the BMP file saved using the software depending on the image

processing software.

7.2  Setting Titles/Comments of Reports and Saving Reports in BMP Format
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7.3 Setting the Printer

Procedure
1. From the File menu, choose Print Setup.  The Print Setup dialog box opens.

2. Enter appropriate settings for Printer, Size, Source, and Orientation.

3. Click OK.

Note
Always use A4-sized paper when printing.  Depending on the printer, some portions of the

document may not be printed on the page if paper smaller than A4 is used.

Explanation
Set the printer according to the environment of the system that you are using.



7-8 IM 761922-02E

7.4 Previewing the Printout

Procedure
Note

• Print preview of reports cannot be displayed when the measurement mode is set to Harmonic

Monitor or Waveform Monitor or when no measured data or waveform data is present.

• Print preview of reports cannot be displayed when measurement is in progress.

Displaying the Print Preview of the Screen Image
1. From the File menu, point to Preview and then choose Display Image.  The

screen image that is present when Display Image is selected is previewed.
The screen image data of an active window such as acquisition data, bar graph, list,

and waveform windows is previewed.

2. You can perform various operations such as Next Page/Prev Page, One Page/
Two Page, and Zoom In/Zoom Out.  Click Print to print the image (see section

7.5).

Display Example: Print Preview Window



7-9IM 761922-02E

S
avin

g
/P

rin
tin

g
 S

creen
 Im

ag
es an

d
 R

ep
o

rts

7

Displaying the Print Preview of Reports
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,
the selectable input element to be previewed also varies.  Below a procedure is given
in which the wiring system of the WT3000 is set to single-phase two-wire (1P2W) and

one input element is used.

When the measurement mode is set to Harmonic Measurement and the measured

data or waveform data has been retrieved (or loaded), the print preview of the report
can be displayed.
1. Choose File > Preview > Report > Element1.  The report is previewed on the

Report Preview window.

2. You can perform various operations such as Next Page/Prev Page, One Page/
Two Page, and Zoom In/Zoom Out.  Click Print to print the image (see section
7.5).

Display Example: Print Preview Window

7.4  Previewing the Printout
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Explanation
You can preview the print image on the screen.  Perform various operations on the print
preview window according to the PC environment that you are using.

Print Preview of the Screen Image
The screen image data of an active window such as acquisition data, bar graph, list,
and waveform windows is previewed.

Print Preview of Reports
When the measurement mode is set to Harmonic Measurement and the measured

data or waveform data has been retrieved (or loaded), the report can be previewed.
• The report that uses the average and maximum data can be previewed for each

input element.
* Average: Average of the individual data points (instantaneous values) within the

measurement time for each order.

Maximum: The maximum value among the individual data points (instantaneous values)

within the measurement time for each order.

• For Class C equipment, the limit that was used is also displayed.
• For Class C equipment with an active input power less than or equal to 25 W,

waveforms as described in section 4.5 are also previewed, if waveforms are being

used for evaluation.
• The input element on which harmonic measurement is made varies depending on

the wiring system configuration of the WT that you are using (see chapter 8).

Therefore, the selectable input element to be previewed also varies.

Selecting Color/Mono for Reports
The print mode is selected in the title/comment setting of reports (see section 7.2).  If
Color is selected there, the preview is displayed in color.  If Mono is selected, the
preview is displayed in black and white.

7.4  Previewing the Printout
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7.5 Printing

Procedure
Note

• Printing of reports cannot be displayed when the measurement mode is set to Harmonic

Monitor or Waveform Monitor or when no measured data or waveform data is present.

• Reports cannot be printed when measurement is in progress.

Printing Screen Images
1. From the File menu, point to Print and then choose Display Image.  The Print

dialog box opens.  You can also choose Display Image from the Print icon on

the toolbar.

2. Set the Printer, Print range, and Copies.
3. Click OK.  The screen image that was present when Display Image was

selected in step 1 is printed.
The screen image data of an active window such as acquisition data, bar graph, list,

and waveform windows is printed.



7-12 IM 761922-02E

Print Example

7.5  Printing
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Printing Reports
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,
the selectable input element to be printed also varies.  Below a procedure is given in
which the wiring system of the WT3000 is set to single-phase two-wire (1P2W) and

one input element is used.

When the measurement mode is set to Harmonic Measurement Mode and the

measurement data has been acquired (or loaded), the report can be printed.
1. Choose File > Print > Report > Element1.  The Print dialog box opens.  You

can also choose Print > Report > Element1 from the toolbar.

2. Set the Printer, Print range, and Copies.
3. Click OK.  The reports that use the average and maximum data are printed on

separate pages.

7.5  Printing
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Print Example (Image)

7.5  Printing
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Explanation
Set the printer according to the environment of the system that you are using.

Printing Screen Images
The screen image data of an active window such as acquisition data, bar graph, list,
and waveform windows is printed.

Printing Reports
When the measurement mode is set to Harmonic Measurement and the measured
data has been retrieved (or loaded), the report can be printed.

• The report that uses the average and maximum data can be printed for each input
element.
* Average: Average of the individual data points (instantaneous values) within the

measurement time for each order.

Maximum: The maximum value among the individual data points (instantaneous values)

within the measurement time for each order.

• For Class C equipment, the limit that was used is also printed.

• For Class C equipment with an active input power less than or equal to 25 W,
waveforms as described in section 4.5 are also printed, if waveforms are being
used for evaluation.

• The input element on which harmonic measurement is made varies depending on
the wiring system configuration of the WT that you are using (see chapter 8).
Therefore, the selectable input element to be printed also varies.

Selecting Color/Mono for Reports
The print mode is selected in the title/comment setting of reports (see section 7.2).  If

Color is selected there, the report is printed in color.  If Mono is selected, the report is
printed in black and white.

• Printing of the Power Values That Are Excluded from Applying the Limits
The power values that are excluded from applying the limits are printed for Classes A,
B, and D. The printed contents vary depending on the selection made in “Selecting

the Lower Power Limit for Applying the Limits” in section 3.5.

Lower Power Limit for Applying the Limits Printed Contents
Selected in Section 3.5

50W 50W
75W 75W
None -------
Infinity Always excluded from applying the limits

7.5  Printing
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Chapter 8 Setting WT Measurement Conditions

8.1 Setting the Measurement Conditions of the
WT3000

Procedure
1. Select WT3000 in the Select WT dialog box. While online, choose Setting > WT

Setting. You can also choose WT Setting from the Setup icon on the toolbar.

You can set the measurement conditions of the target WT.

2. On the WT Setting dialog box, select the Simple Mode or Detail Mode tab.
3. Set the measurement conditions of the WT on the WT Setting dialog box. When

an item is changed on the dialog box, the corresponding measurement condition

of the target WT is changed.

Simple Mode Dialog Box
WT setup mode
Select the WT setup mode.

Wiring system
Select the wiring system of the measurement circuit.

PLL source
Select the signal source of the 
fundamental period used as a 
reference for determining the 
harmonic orders.
Measured item
Select the wiring unit for 
measuring the harmonics.

Measurement range of 
voltage/current
Set for each element.
 • Select the voltage range and 

current range.
 • Set the scaling value of the 

external current sensor input.
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Detail Mode Dialog Box

Measurement range of voltage/current
  Set for each element.

  • Select the wiring compensation.
 • Turn the frequency filter On/Off.
 • Select the voltage range and current range.
  • Set the VT ratio, CT ratio, and scaling factor.
 • Set the scaling value of the external shunt.
 • Copy the filter to the same wiring units.
 • Copy the range to the same wiring units.
  • Copy the scaling to the same wiring units.

WT setup mode
Select Simple Mode or Detail 
Mode.

Wiring system
Select the wiring system of the measurement circuit.

PLL source
Select the signal source of the fundamental 
period used as a reference for determining 
the harmonic orders.

Measured item
Select the wiring unit for measuring the 
harmonics.

Compensation for the two-wattmeter method
Select On or Off.

Note
• When the wiring system is pattern 1 (when all are 1P2W), filter, range, and scaling are copied

to all other elements.

• When taking measurements with this software, the antialiasing filter cutoff frequency is fixed

at 5.5 kHz.

• To make accurate measurements, turn ON the frequency filter of the input element set to PLL

source.

• The exponential average function of the WT3000 is ON.

8.1  Setting the Measurement Conditions of the WT3000
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Explanation
The measurement conditions of the WT3000 can be set from the software via the GP-IB
or Ethernet interface.
• For a description of the setting of the conditions used when retrieving the measured

harmonic data into the PC, see chapter 3. For a description of the procedure of
displaying the retrieved measurement data and waveform data, see chapters 4 and 5,
respectively.

• The menu used to select the input element of the target data varies depending on the
wiring system specified here when displaying or saving measured data/waveform data
or creating, saving, or printing (see chapter 7) reports.

• When an item is changed on the dialog box, the corresponding measurement
condition of the target WT is changed.

• The software starts communications with the target instrument when the software is

started, the communication mode is set to On-Line mode, and the GP-IB address is
selected. At this point, the software loads the measurement conditions of the target
WT and applies the conditions to the settings shown on the WT Setting dialog box. If

communication fails and the measurement conditions of the WT cannot be retrieved,
the settings shown on the WT Setting dialog box become factory default settings of
the WT.

For the setting details and setup procedure on the WT of the following parameters, see
the referenced sections in the User’s Manual IM760301-01E or IM760301-51E.

Parameter Reference Section in the User’s Manual

Wiring system IM760301-01E Section 4.1

PLL source IM760301-51E Section 7.5

Compensation for the two-wattmeter method IM760301-01E Section 5.8

Wiring compensation IM760301-01E Section 5.8

Frequency filter IM760301-01E Section 4.8

Measurement range of voltage/current IM760301-01E Sections 4.3 and 4.4

Scaling IM760301-01E Section 4.5

8.1  Setting the Measurement Conditions of the WT3000
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Chapter 9 Other Functions

9.1 Cascading/Tiling Graph and List Windows

Procedure
Cascading and tiling window functions are convenient for arranging the display.

Cascading Windows
From the Window menu, choose Cascade.  Windows are cascaded so that the
titles of all displayed windows can be seen.

Display Example

Tiling Windows
From the Window menu, choose Tile.  All the displayed windows are tiled so
that the windows do not overlap each other.
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Display Example

Explanation
Window functions are useful, when the measurement mode is set to Harmonic
Measurement, the measured data is retrieved (or loaded), and multiple graphs or lists
are displayed.

Cascade
• Windows are cascaded so that the title of all displayed windows can be seen.

• The active graph or list window becomes the front window after the cascade
operation.

• The cascade order varies depending on the type of displayed window.

Tile
• All the displayed windows are tiled so that the windows do not overlap each other.

• The active graph or list window becomes the active window after the tile operation.
• The arrangement order varies depending on the type of displayed window.

9.1  Cascading/Tiling Graph and List Windows
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9.2 Arranging Icons

Procedure
From the Window menu, choose Arrange Icons. All the minimized windows

(icons) are arranged at the lower left corner of the main window of the software.

Main window

Minimized windows (icons)

Explanation
This function is useful when various windows such as acquisition data, bar graph, and

list windows have been minimized (icons) and the icons have been moved (within or
outside the main window of the software).
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9.3 Using the Help Function

Procedure
From the Help menu, point to Help Topics and choose User’s Manual. If Adobe

Reader is installed in the PC, Adobe Reader starts and shows the PDF file of
the User’s Manual of this software. You can also click  on the toolbar.

Explanation
Online Help
The user’s manual is displayed as a help document in PDF (Portable Document Format).
You can find information about operating procedures of this software and terminology.
You can view PDF files using Adobe Reader, a freeware.

If there is an alteration notice, you can choose Help > Help Topics > Alteration Notice
from the toolbar to view the PDF file of the alteration notice.

Viewing the Most Recent User’s Manual or Alteration Notice
To obtain the most recent PDF files of the user’s manual and alteration notice, click
“Manual Download” on the YOKOGAWA’s Web page shown below. Then, download the

users manual and alteration notice of this software program.
www.yokogawa.com/tm/wtpz/761922/tm-761922_01.htm
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Rename the downloaded user’s manual and alteration notice as indicated below
according to the product that you are using, and copy (overwrite) the files in the software

installation folder that you specified when you carried out the steps on page 2-8. You will
be able to view the most recent operating instructions by selecting the user’s manual or
alteration notice from the Help menu.

Product User’s Manual File Name Alteration Notice File Name

WT3000 IM761922-02E.pdf AlterationsEWT3000.pdf

WT1600 IM761922-01E.pdf AlterationsEWT2000.pdf
WT2000 series

Note
• You can download Adobe Reader from Adobe System’s Web page.

• The most recent user’s manual and alteration notice that you can download from

YOKOGAWA’s Web page correspond to the most recent version of this software program.

Update the software program as necessary. The program for updating the software can be

downloaded from YOKOGAWA’s Web page above.

9.3  Using the Help Function
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9.4 Viewing Version Information

Procedure
From the Help menu, choose About.  The Harmonic Analysis Software version

information dialog box opens.

Harmonic Analysis Software Version Dialog Box

Explanation
The name and version information of the software is displayed.

Note
• The software version is different for each operation mode indicated below.

• Harmonic measurement function

• Voltage fluctuation and flicker measurement function

If either function is updated, the version of the other function may not change.

• For the most recent version of the software, check the YOKOGAWA’s Web page below.

www.yokogawa.com/tm/wtpz/761922/tm-761922_01.htm

The program for updating the software as well as the most recent user’s manual

andalteration notice (see section 9.3) can be downloaded from YOKOGAWA’s Web page

above.
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Item Specifications

Software* This software application (761922) measures harmonic currents of electrical equipment according to
the IEC or JIS standard and indicates/saves the results of evaluations made according to the
standard. The executable file name is IEC61000.exe.

Applicable instruments* • WT3000 (models 760301, 760302, 760303, and 760304)
• WT1600 (model 760101)
• WT2000 series (models 253101, 253102, and 253103)

Applicable standard* IEC 61000-3-2 (Electromagnetic compatibility (EMC) - Part 3-2: Limits - Limits for harmonic current
emissions (equipment input current ≤ 16 A per phase)) Edition 3.0 and A1 of the Edition 3.0
• EN61000-3-2 (2006)
• IEC61000-4-7 Edition 2
• JIS C61000-3-2 (2005), abbreviated as JIS

Functions Retrieving and loading measured data/waveform data to be evaluated
• Setting of WT measurement conditions.
• Retrieving of measured data or waveform data from the WT connected online (On-Line Mode).
• Loading of measured data or waveform data already saved (Off-Line mode).

Measurement mode *

• Harmonic Measurement Mode
• When in On-Line Mode

Measures and evaluates harmonics on the measurement data retrieved from the WT
according to the method complying with IEC61000-3-2 Edition 3.0 or JIS.

• When in Off-Line Mode
Evaluation can be made on the loaded measurement data according to the method
complying with IEC 61000-3-2 Edition 3.0 or JIS.

• Harmonic Monitor Mode
Monitor harmonic fluctuation on bar graphs and numerical list while making measurements on
the WT only in On-Line mode.

• Waveform Monitor Mode
Monitor waveforms while making measurements on the WT on in On-Line mode.

Standard and measurement environment
Sets the classification of the equipment under test (EUT) as defined in IEC 61000-3-2 Edition
3.0 or JIS and evaluation conditions within each class.

Measurement time
Time from measurement start to measurement stop.
Selectable range: 0 H 0 M 1 S to 24 H 0 M 0 S in units of 1 s.

Title/Comment of reports
Sets the title/comment of reports. You can select color or black and white as well as
Japanese or English for reports. Saved/Printed along with the measured data.

Starting/Stopping of measurements
Measurement can be started in On-Line mode.

Displaying of the evaluation results and measured data/waveform data
Only when the measurement mode is set to Harmonic Measurement, displays the result of
the evaluation as whether the harmonic current data up is within the limits of IEC 61000-3-2
Edition 3.0 or JIS and the corresponding measured data.
• Display of the evaluation result within the entire measurement time

Evaluates as to whether all of the harmonic measurement data in the measurement time
are within the limits and display the results.

• Bar graph display of harmonic current/voltage
Displays bar graph of the harmonic measurement data and the standard limits for each
order.

• List display of harmonic current/voltage
Displays a list of the harmonic measurement data and the standard limits for each order.

• Fluctuation graph display of harmonic current
Displays the graph of the harmonic current fluctuation over time for each order.

• Waveform display of voltage/current
Displays the waveform immediately after stopping measurement (approximately 2 periods
of the waveform on the WT2000/WT3000 or approximately 4 periods on the WT1600).
Place the cursor on the current waveform and read the phase difference (phase angle)
from the first zero-crossing point of the voltage waveform and the current value.

Chapter 10  Specifications
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Item Specifications

• Fluctuation graph display of voltage/current/active power
Displays the graph of the fluctuation of the rms value of the voltage and current as well as
the active power that are determined from the measured fundamental signal and all
harmonics.

• Bar graph display of the phase angle of the harmonic current
Displays the bar graph of the phase angle of the harmonic current with respect to the
fundamental signal for each order.

• List display of the phase angle of the harmonic current
Displays a numerical list of the phase angle of the harmonic current with respect to the
fundamental signal for each order.

Loading of setup information, measured data, and waveform data
• Saving and loading of data

Save to a file setup data including the measurement mode, standard and measurement
environment settings, measurement time, title/comment of reports. Loading of the setup data
is also possible.

• Loading of measured data and waveform data
Save measured data or waveform data of harmonics to files. Setup data such as the
measurement mode, standard and measurement environment settings, measurement time,
title/comment of reports and the harmonic measurement conditions of the WT specified by the
software are also saved. Loading of the saved measured data, waveform data, harmonic
measurement conditions, and setup information is also possible.

• Saving of the measured data or waveform data in CSV format
Save the measured data or waveform data of harmonics to a file in CSV format. The saved
data can be loaded on a PC software application supporting CSV format.

Saving/Printing of screen images and reports
Save screen images or reports to a file in BMP format. Printing also possible.

Repeatability of measured data
Compares the harmonic measurement data that is saved to files, and displays the difference
in the measured data on a bar graph and numerical list. Enables confirmation of whether the
difference between data measured using the same product is within 5% as defined by the
standard (confirmation of repeatability).

System requirements PC
• CPU

Pentium III 1 GHz or equivalent or faster
• Memory

256 MB or more
• Hard disk

Free space of at least 2 GB.

Operating System
Windows 2000 Professional, Windows XP Home Edition, or Windows XP Professional.

Communication card
• GP-IB

PCI-GPIB/PCI-GPIB+/PCMCIA-GPIB/PCMCIA-GPIB+ by National Instruments with NI-488.2
driver version 1.60 or later (however, version 2.3 is not supported).

• Ethernet
A 100BASE-TX Ethernet port.

Display, Printer, and Mouse
Must be compatible with the operating systems listed above.

WT Digital Power Meter
WT3000 firmware version 3.01 or higher with the following functions.
• Advanced computation function (option)
• GP-IB interface (standard) or Ethernet interface (option)

* • The width of the window function (measurement period) for the measurements on the WT3000 is 200 ms (10 cycles at 50
Hz and 12 cycles at 60 Hz) as defined by IEC61000-4-7 Edition 2.

• The width of the window function (measurement period) for the measurements on the WT2000/WT1600 is 16 cycles as
defined by IEC61000-4-7 (1991).

• The WT1600 supports analysis methods based on the standard. However, measurements complying with the standard
cannot be performed due to the limitation in the measurement accuracy.

Specifications
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Compatibility between the WT3000 Precision Power Analyzer and IEC
In the EN61000-3-2:2006 (IEC61000-3-2 Edition 3.0:2005) standard, the requirements

for measurement instruments are specified in EN61000-4-7 (IEC61000-4-7).
The WT3000 complies with the items related to EN61000-3-2:2006 (IEC61000-3-2
Edition 3.0:2005) of EN61000-4-7:2002 (IEC61000-4-7 Edition 2.0:2002) in the range

indicated in the table below.*1

Item EN61000-4-7:2002 WT3000 Compliance
IEC61000-4-7 Edition 2.0:2002

Current measurement 5% of the permissible limits or Frequency of the 40th order of the Compliant within the range
error 0.15% Ir of the rated current Ir, fundamental frequency 60 Hz in the left column for direct

whichever is greater When the crest factor is 3, input
2.5% of reading+0.05% of range
→ Error within 5% at the limit that is greater than or equal to 2% of the
input range.
When the crest factor is 6, 2.5% of reading+0.1% of range
→ Error within 5% at the limit that is greater than or equal to 4% of the
input range.
Accuracy at 2.4 kHz (direct input)

Instrumental loss of Voltage drop of 0.15 Vrms or Instrumental loss  Approx. 5.5 mΩ + Complies up to approx.
the current input circuit less approx. 0.03 µH 27 Arms

Crest factor of the 5 Arms range or less: 4 3 or 6 Compliant
current input circuit 10 Arms range or less: 3.5 With overload display

Range above 10 Arms: 2.5
Overload display is necessary.

Range structure of the Direct input range: 0.1, 0.2, 0.5, 0.5, 1, 2, 5, 10, 20, 30 A range Compliant in the rangc
current input circuit 1, 2, 5, 10, 20, 50, and 100A (when the crest factor is 3) indicated in the left column.
and withstand ranges are desirable 0.25, 0.5, 1, 2.5, 5, 10, and 15A range To make accurate
overload input (when the crest factor is 6) measurements, pay

External sensor range: 0/1 V to 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10 V attention to the crest factor
10 V are adequate. (when the crest factor is 3) and range slections.

0.025, 0.05, 0.1, 0.25, 0.5, 1, 2.5, 5 V
(when the crest factor is 6)

Excessive input is 1.2 times Direct input
the range (continuous) and Peak value of 90 A or rms value of 33 A, whichever is less (continuous)
10 times (1 s) Peak value of 150 A or rms value of 50 A, whichever is less (1 s)

External sensor input
Peak value less than or equal to 5 times the range (continuous)
Peak value less than or equal to 10 times the range (1 s)

Anti-aliasing filter 50 dB or higher 50 dB or higher for harmonic components Compliant
up to the 40th order at the fundamental
frequency 50/60 Hz

Window function shape Rectangular Rectangular Compliant

Window width 10 cycles (50 Hz)/12 cycles 10 cycles (50 Hz)/12 cycles (60 Hz) Compliant
(60 Hz)

Relative deviation of Within ±0/03% Within ±0/03% Compliant
the sampling frequency
and fundamental
frequency

Grouping of Required Grouping function available Compliant
interharmonics

Smoothing Time constant: 1.5 s Time constant: 1.5 s Compliant

Window gap and No gap and no overlap No gap and no overlap Compliant
overlap

General specifications The effects of temperature, See the items in the general specifications Compliant in the range of
humidity, supply voltage, the general specifications
common-mode voltage, static
electricity, and electromagnetic
field must be specified.

*1 This software operates in accordance with IEC61000-3-2 Edition 3.0 Amendment 1 which states that the repeatability of the
average value shall be better than ±5% of the applicable limit. As of September 1, 2008, EN61000-3-2 (2006) does not have a
clause that corresponds to this amendment.
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